
Before using the instrument, be sure to read this manual thoroughly.
Keep the manual where it is easily accessible.

Operation Manual

Retinal imaging control software NM
(CR-1 Mark II)



PLEASE NOTE
1. For 110/120V countries:

Computer and monitor used in the retinal imaging control software NM must be conforming to the 
IEC60601-1/UL60601-1 or IEC60950/UL60950. Be sure to also use an isolation transformer conforming to 
IEC60601-1/UL60601-1 when a computer or monitor conforming to IEC60950/UL60950 is used.
For 220/230/240V countries:
Computer and monitor used in the retinal imaging control software NM must be conforming to the 
IEC60601-1/UL60601-1.

2. Reading of image and storage of data must be performed in accordance with the law of the country where 
the product is being used. Also, the user is responsible for maintaining the privacy of image data.

3. In no event will Canon be liable for direct or indirect consequential damage arising out of the use of this 
product.
Canon will not be liable for loss of image data due to any reason.

4. Before installing this product, you must read through the license agreement covering the terms and 
conditions under which the software is to be used.

5. Please ask the distributor or Canon representative where you made the purchase to install this product.
6. Canon reserves the right to change the specifications and other aspects of this product without prior notice.

• Microsoft and Windows are either registered trademarks or trademarks of Microsoft Corporation in the 
United States and/or other countries.

• Other systems and product names in this manual are the trademarks of each manufacturer that developed 
them.

© CANON INC. 2009

All rights reserved.
Under copyright laws, this manual may not be copied, in whole or in part, without the written consent 
of Canon.
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NOTATION

Notation 1
Button names are indicated by [ ].

Notation example: Click [OK].

Notation 2
Available options in the taskbar or menu bar are indicated by [ ], and when options are selected in submenus, the 
order of selection is indicated by >. The available shortcut keys are displayed after the option in the menu bar.

Notation example: Click the commands from the taskbar in the following order.
[Start] > [All Programs] > [Canon Retinal imaging control software NM] > 
[Canon CR-1 Mark II]

[Study] > [Skip Study Input F5] 

Notation 3
For check boxes,  indicates a checked option, and  indicates an unchecked option.

Notation example: When this is checked, a Warning screen will be displayed when the amount of free space on the 
hard disk has fallen below the setting.

Notation 4
For radio buttons,  indicates a selected option, and  indicates an unselected option.

Notation example: Select Manual or By User Defined Code.

Notation 5
If an operating procedure or description in a section continues from an odd-numbered page to an even-numbered 
page, “Continued on the following page>>” is written at the bottom right of the odd-numbered page.

Notation 6
If a detailed explanation for the operation or setting is available on another page, the notation (see page number) is 
used to refer to this page.

Notation example: 1. End the study. (see page 25)
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1. Introduction

1.1 Overview of software
This software is used when taking retinal images with Canon Digital Retinal Camera CR-1 Mark II, and it 
enables the images taken to be browsed, operated, processed, stored, sent to DICOM storage server, 
exported as DICOM or JPEG format file and, output to a printer.

This software provides SCU functions of the Modality Worklist Management Service Class, Modality 
Performed Procedure Step Service Class and DICOM Storage Service Class in compliance with the 
DICOM standards.

This software enables connection to an HIS, RIS or other system, and worklists can be obtained to input 
study.

This software enables searches and studies using list input and using input from magnetic cards/barcode 
readers.

When a study is completed, the image data, study information and patient information are saved in the 
database managed by this software. Studies saved in the database can be saved to any user-selected 
storage. Studies from this location can also be viewed.

When images are output to the DICOM server or exported DICOM format file, DICOM format images are 
created with the information stored in the database.

C/D ratio measurement, stereo view, and other operations are available for enabling easy diagnosis of 
images.
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1.2 Software operating environment
For details on the system, contact a Canon representative or distributor.

Hardware or software Specifications

CPU Core 2 Duo 2 GHz or higher

RAM 2 GB or more

Display
Screen resolution: XGA (1024 × 768 pixels) or higher 
WXGA (1280 × 800 pixels) or higher recommended

Screen colors: 24 bits or more

Keyboard

Mouse Microsoft Mouse or compatible mouse

Interface

USB2.0 (for communication with digital camera)

USB1.1 (for communication with retinal camera: emulating RS-232C)

RS-232C (for the magnetic card/barcode reader)

Operating system
Microsoft Windows XP Professional SP2/SP3 [US]*
Microsoft Windows Vista Business SP1 [US]*
* This software does not support x64 (64-bit version).

Software

Microsoft .NET Framework Version 3.5

SQL Server 2005 Express Edition SP2

Canon Easy-PhotoPrint EX Version 2.0.0 or later (for printing the images)

Compatible EOS EOS 50D
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2. Notes on use

2.1 Software

(1) This software can only be used by users who belong either of the following groups of the 
User Accounts.
Windows XP: Administrators
Windows Vista: Users (Standard user) or Administrators

(2) Be sure to set the access rights for the saving folder to be used in the following cases.

• When exporting files to the Storage Types of the Export (DICOM) or Export (JPEG)
• When changing the saving directory for the study management to a folder other than 

the default folder (Installation folder\Database\Images)
• When saving the temporarily saved study logs
• When using a study file for list input (such as ccrhis.his)

In the Security tab under Folder Properties, set Allow for Modify in the Users group and 
Allow for Full Control in the Administrators group.

(3) Please use care with the following when saving the temporarily saved study logs or 
viewing the study log files.

• To specify a folder on the network, get the access rights to the folder as the Windows 
login user. For details on the access rights on the network, contact the system 
administrator.

• Do not set the password on the removable media (CD, DVD or flash drive etc.).

(4) Do not use the “Switch User” (where the user is switched without logging off) function in 
Windows. When multiple users are using the software, be sure to select “Log Off” in Log 
Off Windows, and then log in again as a different user.

(5) Do not attempt to change the OS settings (such as screen resolution, date format, date, 
or language) while the application is running. If changes are made while the application is 
running, it may not function properly.

(6) When using this software, make the Screen saver and Power Options settings as shown 
below.

Windows XP:

Screen saver None

Turn off monitor Never

Turn off hard disks Never

System standby Never

When I press the power button on 
my computer Shut down

Enable hibernation Disable
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Windows Vista:

Also, during the Windows shut down process, do not perform any of the following 
operations.

Windows XP: Standby
Windows Vista: Sleep

(7) Do not operate the retinal camera while operating this software. The software and 
camera may fail to operate properly.

(8) After taking the image, do not operate the software until importing of the image is 
completed. Otherwise, it may not function properly.

(9) Check cable connections if a communication error with the retinal camera occurs. Restart 
the computer if the communication error still occurs even after all cable connections have 
been checked.

(10) If an application error is displayed during a study, turn the retinal camera and digital 
camera off and then on again, and restart the PC.
In this case, perform the procedure below.

1) Turn off the retinal camera and digital camera.
2) Turn off the PC.
3) Turn on the PC.
4) After the OS is started, turn on the retinal camera and digital camera.

(11) While images are being transferred from the digital camera, do not turn off the retinal 
camera or disconnect the DC coupler of the digital camera and the cables between the 
PC and retinal camera.

(12) If this software freezes or the image cannot be displayed, turn the retinal camera and 
digital camera off and then on again, and restart using the procedure below.

1) Turn off the retinal camera and digital camera.
2) Turn off the PC.
3) Remove the DC coupler of the digital camera, and then reinsert it.
4) Turn on the PC.
5) After the OS is started, turn on to the retinal camera and digital camera.

Screen Saver None

Turn off the display Never

Put the computer to sleep Never

Turn off hard disks Never

When I press the power button Shut down

Start menu power button Shut down
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(13) Properties settings for the EOS digital camera
To prevent a wizard or menu opening when the EOS digital camera is connected, perform 
the procedure below.

Windows Vista:
1) Open the Control Panel, and click Hardware and Sound, and click Play 

CDs or other media automatically.
2) Select “Take no action” from the drop-down list for Canon EOS 50D. 

Then, click [Save]. 

Windows XP: 
1) Select Scanners and Cameras in the Control Panel.
2) Right-click Canon EOS 50D, then open the Properties screen.
3) Click the Events tab and select “Take no action”, then click [OK]. 

2.2 Digital camera settings

(1) This software can only be used for digital cameras that were set by service personnel at 
installation. For details on the supported digital camera and to change the digital camera 
that is used, please contact a Canon representative or distributor.

(2) The settings may vary depending on the digital camera model.

(3) Do not make any improper changes to the digital camera settings. If the proper settings 
are not made, the camera may be unable to take images. After changing the settings, 
turn off the power switch to the digital camera to save the settings.

Setting example (EOS 50D)
For details on settings, see the EOS 50D Instruction Manual.

Note: Items listed as “Auto” in the Remarks column are automatically set by this software. Items 
listed as “Required” show items where retinal images cannot be taken unless the settings 
are made as indicated.
Items listed as “Recommended” are settings recommended by Canon. The customer 
should act responsibly when making setting changes.

Basic settings

Item Settings Remarks

Shooting mode M (Manual exposure) Auto

Drive mode  (Single shooting) Auto

White balance  (Flash) Auto

Shutter speed 60 (1/60 sec) Auto

ISO speed 1600 • 3200 • 6400 Auto
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Settings based on menu functions
The settings for menu items not shown here can be changed as desired.

2.3 CF cards

(1) Do not insert CF cards into the digital camera.

Note: After turning on the digital camera or using the menu button, “No card” (“No CF card”) and 
“Sensor cleaning” are displayed once only on the LCD monitor of the digital camera. This 
is not an error.

Menu items Settings Remarks

AEB 0 Required

WB SHIFT/BKT 0,0/±0 Required

Color space sRGB Required

Picture Style Neutral Auto

Review time Off Required

Auto power off Off Required

Date/Time Set to the correct date and time Recommended

C.Fn I: Exposure 3 ISO expansion Set Auto

C.Fn II: Image 2 
High ISO speed noise reduction 0 Auto

Shoot w/o card On Required

Live View function settings
[Live View shoot] Disable Auto
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3. Starting up and exiting the software

3.1 Starting up the software and logging in

Note: Before proceeding, log in as a user who has an appropriate access rights in Windows. 
For details, refer to (2) in 2.1 Software (see page 3).

Check that the power of the retinal camera is on, and either double-click the Canon CR-1 Mark II icon on 
the desktop or from the taskbar click [Start] > [All Programs] > [Canon Retinal imaging control 
software NM] > [Canon CR-1 Mark II] in this order. The login screen will appear.

Login screen

Objective Operation
Reference chapter 

and page

Performing 
studies

Input the User ID and Password, and click [Login].
The main screen is displayed.
User ID distinguishes neither upper-case letters nor lower-
case letters.

4. Performing 
studies (see page 9)

Setting the 
software

Input the User ID and Password with which the Privilege 
(see page 100) has been set to the Administrator, and 
click [Settings].
The setting screen is displayed.
User ID distinguishes neither upper-case letters nor lower-
case letters.

7. Settings (see 
page 73)

Exiting the 
software

Click [Exit].
However, it cannot be clicked while images are being 
transferred.

3.2 Exiting the 
software (see 
page 8)



3. Starting up and exiting the software

-8-

3.2 Exiting the software
When the software is to be exited, exit it on the login screen.
The steps taken to return to the log-in screen differ depending on whether the setting screen or the main 
screen is displayed.

Screen Operation

Setting screen

1. Return to the setting menu screen.
2. On the setting menu screen, click [Close] to return to the login screen 

(see page 73).
3. On the login screen, click [Exit].

Main screen
1. End the study. (see page 25)
2. Log off. (see page 29)
3. On the login screen, click [Exit].

Icon displays on the login screen
If there is a study which is being transferred, the Transfer icon is displayed on the login screen; if 
there is a study with a transfer error, the Transfer Error icon is displayed instead.

Display of Transfer Error icon

[Exit] cannot be clicked while the Transfer icon  is displayed so wait until the transfer is 
completed and the icon is cleared.
If [Exit] is clicked while the Transfer Error icon  is displayed, a Warning screen will appear.

Warning screen

If this is the case, the Transfer Error screen (see page 28) will appear when next logging into the 
system.



-9-

4. Performing studies

4.1 Displaying the main screen
On the login screen, input the User ID and Password, and click [Login]. The main screen is displayed.
For details on the main screen, refer to 6. Main screen operations (see page 41).

Main screen

If there is a study with a transfer error
If there is a study whose transfer status (see page 31) is a transfer error, the error message 
screen and Re-Transfer Study(ies) of Failed Transfer screen are displayed.
If this is the case, refer to 4.5.3 When a transfer error occurs (see page 28).
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4.2 Inputting the study
4.2.1 Methods of inputting the study

There are four methods below for inputting the study: 
1. Manual input (see page 11) 
2. Magnetic card/barcode input (see page 13)
3. List input  (see page 16)
4. Worklist input (see page 19).
Up to three sets of study can be input, after which it is no longer possible to click the Study icon.
When a multiple number of sets of study have been input, click the study tab to select a study.

The following information is displayed on the study tab.

Item Description

Patient Name This item is indicated as the Patient Name.

Patient ID This item is indicated as the ID: Patient ID.

Accession No.
This item is indicated as the No. Accession No. However, if both the 
Patient ID and Accession No. have been input, only the Patient ID will be 
displayed.

Study tab
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Continued on the following page >> 

4.2.2 Manual input
Input the study using the keyboard and mouse.

1 Display the Study Input screen.

Click the Study icon, or [Study] > [Study F1] from the menu bar.
If a tab other than Manual Input is displayed, click the Manual Input tab.

Study Input screen (Manual Input tab)

2 Input the study.

The names of the items which have been set as Essential Data (see page 83) are indicated in blue.
However, if the Patient Name has been set as an Essential Data, only Last Name and/or First Name 
will be displayed in blue.
In items where the input format (see page 84) was set, input text of the character type or specific 
character set.

Item name No. of characters Description

Patient ID Not more than 64 characters
The backslash (\) cannot be input.
Characters other than the preset specific 
character set (see page 76) cannot be 
input.
Results organized based on the input 
format (see page 84) settings are 
displayed with square brackets [ ] at the 
right of the input item field.

Accession No. Not more than 16 characters

Last Name

The total for these items must 
not be more than 60 
characters. Separate each 
item with “^”.

The backslash (\) and equal sign (=) 
cannot be input.
Characters other than the preset specific 
character set (see page 76) cannot be 
input.
If the patient name has been set as an 
Essential Data, an error will result unless 
at least one form of the name is input.

First Name

Middle Name

Prefix

Suffix

Birth Date How this is input depends on the birth 
date input setting (see page 83).

Sex Select either Male, Female or Other.
Ethnic Group Click  and select the Ethnic Group.
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3 Display the main screen.

Click [OK]. The main screen is displayed, and the study information is displayed on it.
When the new study is input, the study is registered on the Patient History.

Main screen

Study Description Not more than 64 characters

The backslash (\) cannot be input.
Information input in Study Description is 
displayed in the Study Description section 
in the main screen.
Characters other than the preset specific 
character set (see page 76) cannot be 
input.

To re-input previously input study
To re-input previously input study, click study information from the Patient History.
To search the Patient History, input the search condition, and click [Search history list]. Only 
those studies matching the conditions are now displayed.

How the system determines whether to treat the input study as a new study
The Patient ID, Last Name, First Name, Middle Name, Prefix, Suffix, Birth Date and Sex of 
the study which have been input are compared with the study registered on the previously studied 
patient list, and if there is no study all of whose items match the input items, the study is treated as 
new study.

Display items in the Patient History
The Patient History can display the Patient ID, Patient Name, Birth Date, Sex, and Ethnic Group, 
but items that are set as Input-Disabled Data (see page 83) are not displayed.

Input items saved to the Patient History
The input items saved to the Patient History are the Patient ID, Last Name, First Name, 
Middle Name, Prefix, Suffix, Sex, Birth Date and Ethnic Group.

When the Worklist search screen is displayed
If the Worklist search screen (see page 20) is displayed, click [Cancel].

Item name No. of characters Description
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4.2.3 Magnetic card/barcode input
Studies can be input from magnetic cards and barcodes.
Data and communication settings must be made for the magnetic card/barcode reader that is used.
For details, please contact a Canon representative or distributor.
This describes the input procedure after the magnetic card/barcode settings (see page 110) have been 
made.

1 Display the Study Input screen.

Click the Study icon, or click [Study] > [Study F1] from the menu bar.
If a tab other than Mag Barcode Input is displayed, click the Mag Barcode Input tab.
Items that are set as Essential Data (see page 86) appear with the item name in blue.

Mag Barcode Input screen

When the Worklist search screen is displayed
If the Worklist search screen (see page 20) is displayed, click [Cancel].
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2 Input the study from the magnetic card/barcode reader.

Use the magnetic card/barcode reader to input the study.
A search for the input items is performed on the previously studied patient list, and the search results 
are input.
If the input items were already manually input, they are overwritten by the data from the magnetic
card/barcode reader.

Mag Barcode Input screen (after search)

3 Input the required study items manually.

Item name No. of characters Description

Patient ID Not more than 64 characters The backslash (\) cannot be input.
Characters other than the preset specific 
character set (see page 76) cannot be 
input.Accession No. Not more than 16 characters

Patient Name Not more than 64 characters

The backslash (\) and equal sign (=) 
cannot be input.
Characters other than the preset specific 
character set (see page 76) cannot be 
input.
If the patient name has been set as an 
Essential Data, an error will result unless 
at least one form of the name is input.
Input the items separated by a space, 
comma, or circumflex (^) in the order of 
Last Name, First Name, Middle Name, 
Prefix, and Suffix.

Birth Date How this is input depends on the birth 
date input setting (see page 83).

Sex Select either Male, Female or Other.

Study Description Not more than 64 characters

The backslash (\) cannot be input.
Characters other than the preset specific 
character set (see page 76) cannot be 
input.
Information input in Study Description is 
displayed in the Study Description section 
in the main screen.
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4 Display the main screen.

Click [OK]. The main screen is displayed, and the study information is displayed on it.

Changing information input from the magnetic card/barcode reader
The information input from the magnetic card/barcode reader cannot be changed from the Study 
Input screen.
To make revisions, refer to 6.10 Changing the patient information (see page 68).

Patient History information
The input items saved in the Patient History are the Patient Name, Patient ID, Birth Date, Sex 
and Ethnic Group.
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4.2.4 List input
Study information is acquired from the study file (ccrhis.his) and input.

1 Open the Study Input screen.

Click the Study icon, or click [Study] > [Study F1] from the menu bar.
If a tab other than List Input is displayed, click the List Input tab.
The List Input screen that was set in 7.5.4 List Input tab (see page 86) is displayed.

List Input screen

2 Display the Setting Search Condition screen.

Click [Search...] to display the Setting Search Condition screen.

Setting Search Condition screen

When the Worklist search screen is displayed
If the Worklist search screen (see page 20) is displayed, click [Cancel].

List display
Up to 10,000 items can be displayed in the list.
When the item name of the header is clicked, the sequence in which the studies are displayed can 
be changed. However, this does not apply to the No.
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3 Input the search conditions.

Input the search items.

4 Perform a refined search of the list.

Click [OK].
The refined search results are displayed in a list.

List Input screen (Refined search results)

Item name No. of characters
Patient ID Not more than 64 characters
Accession No. Not more than 16 characters
Patient Name Not more than 64 characters
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5 Display the main screen.

Select the study line in the list, and then click [OK].
The main screen is displayed, and the study information is displayed on it.

Refined search using magnetic card/barcode reader
If a study is input from a magnetic card/barcode reader while the List Input screen is being displayed, 
a refined search of the list is conducted based on the search information that was input.
If there is multiple study information (such as Patient Name and Patient ID), a search is performed 
for studies matching all the information, and the search results are displayed in a list.
Also, if a study is input from a magnetic card/barcode reader while the Setting Search Conditions 
screen is being displayed, the search conditions are modified based on the study information that 
was input.
To perform a refined search of the list, click [OK].
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4.2.5 Worklist input
Acquire the worklist from the worklist server.

1 Display the Study Input screen.

Click the Study icon, or click [Study] > [Study F1] from the menu bar.
If a tab other than Worklist is displayed, click the Worklist tab. 
The worklist matching the search conditions set in 7.5.5.3 Setting the search conditions (see 
page 89) is displayed.

Study Input screen (Worklist tab)

Concerning the worklist display
Up to 100 studies can be displayed.
When the item name of the header is clicked, the sequence in which the studies are displayed can 
be changed. However, this does not apply to No.

Header
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2 Display the main screen.

Click the worklist to be acquired, and then click [OK] or double-click the worklist. 
The main screen is displayed, and the information of the acquired worklist is displayed.

Main screen

Concerning worklist server searches
If Display Worklist Search window has been checked in 7.5.5.3 Setting the search 
conditions (see page 89), the Worklist search screen is displayed automatically.
To display the Worklist search screen manually, click [Search...] on the Study Input screen.

Worklist search screen

The search conditions can be changed on the Worklist search screen. Input the conditions, and 
click [OK].
Among the changed search conditions, Patient ID, Patient Name, Accession No. and Requested 
Procedure ID are saved until either the Study Input screen is closed or switching to another 
screen. The other items are saved until either exiting the software or the settings are changed in 
7.5.5.3 Setting the search conditions (see page 89).
When [Default] is clicked, the values which were set in 7.5.5.3 Setting the search conditions 
(see page 89) will be input.
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Searches using a magnetic card/barcode reader during worklist input
If a study is input from a magnetic card/barcode reader while the Worklist Input screen is being 
displayed, a search of the worklist is performed again based on the current worklist search conditions 
and study information that was input from the magnetic card/barcode reader, and the search results 
are displayed in a list. If the Search screen is displayed, the search conditions will be changed.

Study Input screen (Worklist re-search results)
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4.3 Starting a study without opening the Study Input screen
A study can be started as quick as thought skipping input of study information. Enter the patient 
information when the study is completed.

1 Display the main screen.

Click [Study] > [Skip Study Input F5] from the menu bar, or press the F5 key on the keyboard.
The main screen is displayed with the Study tab left blank.

Skip Study Input main screen

2 Display the Study Input screen.

Refer to 4.4 Taking images (see page 23) and 4.5.1 Ending a study (see page 25) to perform 
the study. Click [Study Complete] (see page 24), and the Study Input screen opens automatically.

3 Input the patient information.

Refer to 4.2.1 Methods of inputting the study (see page 10) to input the items, and click [OK] 
to close the screen.

Note: When the setting for the Automatic Accession No. Assignation (see page 85) has been 
made, Skip Study Input is disabled.
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4.4 Taking images

1 Input the Study Description.

A description consisting of up to 64 characters can be input in Study Description.
The identical Study Description is input for all the images which were taken until the study was 
completed.

Study Description

2 Check the Photography ready lamp.

This lamp lights up green if photography is possible.
No photography is possible if it is lighted up red so refer to 7.3 Device (see page 77) and check 
the hardware settings.

To input a comment for each image
In order to input a comment for each image, refer to 6.2.2 Referencing the image properties 
(see page 45).

Photography ready lamp
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3 Take the images.

Press the shutter release button on the retinal camera. The retinal image is taken.

Image

4 Refer to the image.

To operate or print the image, refer to 6. Main screen operations (see page 41).
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4.5 Ending a study and transferring images
4.5.1 Ending a study

1 End the study.

Click [Study Complete]. The Study Complete screen is displayed.
To end the study, click [OK].
To select the storage, follow the steps described below.

Study Complete screen

When [Study Cancel] is selected
When [Study Cancel] is clicked, the Study Cancel screen is displayed. 
If [OK] is then clicked, the study is ended without saving the images which have been taken.

Study Cancel screen

Study Complete and Study Cancel
The same operation can be performed by selecting [Study] > [Study Complete F12] or [Study] 
> [Study Cancel] from the menu bar.

When a study is started without opening the Study Input screen
When a study is started without opening the Study Input screen, click [Study Complete] to 
display the Study Input screen. Refer to 4.2 Inputting the study (see page 10), and input the 
study information.
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2 Display the Select the Storage(s) screen.

Click [Select Storage...].

Select the Storage(s) screen

3 Select the storage.

Click the storage.
To set two storages, click the storage while pressing the Ctrl key on the keyboard.

4 Confirm the storage.

Click [OK]. The Select the Storage(s) screen is exited, and operation returns to step 1.

When [Select Storage...] is disabled
Select “When a study is completed” on the Transfer Timing tab (see page 75) to enable [Select 
Storage...].

If a study was not completed properly
If a study was not completed properly because, for instance, the power of the computer was cut 
off during the course of the study, the main screen will be displayed in the status, which was 
established when the study was last completed, when the user next logs into the system.
In a case like this, an icon  is displayed on the study tab.
If an image was not saved properly, an image with a red “×” will appear on the thumbnail image 
and main image, and the image will be rejected (see page 67).

When an image was not saved properly
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4.5.2 Checking the transfer status
The transfer status is displayed by the icon at the top right of the main screen.
If the transfer is completed properly, the icon display is cleared.

Position of transfer status icon

Icon displays

Icon Status Description

Transfer There is a study currently being transferred.

Transfer 
Error

A transfer error has occurred.
An Transfer Error screen is displayed when this icon is clicked. Refer to 
the message, and take the remedial action.
When retransferring a study, refer to 5.1.3.2 Transferring all studies 
(see page 34).
When the Transfer Error screen is displayed, the Transfer Error icon is no 
longer indicated.

Transfer Error screen

Transfer status icon
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4.5.3 When a transfer error occurs
The transfer status is displayed by the icon on the login screen (see page 8) or main screen.
It can also be displayed on the Study Logs screen (see page 31).
If there is a study whose transfer has failed or an Transfer Error screen which has not appeared even once, 
the Transfer Error icon  will appear on the main screen or login screen.
If the user has logged in or logged off while a Transfer Error icon is displayed, the Transfer Error screen 
will be displayed.
This Transfer Error screen is displayed once, and then cleared.

Transfer Error screen

Re-Transfer Study(ies) of Failed Transfer screen is displayed when the user logs in or logs off while there 
is a study which has resulted in a transfer error.
Re-Transfer Study(ies) of Failed Transfer screen is cleared when the transfer error is remedied.

Re-Transfer Study(ies) of Failed Transfer screen 
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4.6 Logging off
To log off, click the logoff button at the top right of the screen, or select [File] > [Logoff Alt+F4] from the 
menu bar.
The login screen (see page 7) is displayed.

Note: If there is a study in progress, the user cannot log off. Before logging off, be sure to either 
end or cancel the study.

Concerning the transfer of images
If the current transfer status is a transfer error or if an untransferred image exists, the same 
operation is performed as when [Transfer All] is executed on the study logs (see page 34).

When there is a study which has exceeded its storage period
A study can be deleted only after it has been saved for the period set by the Storage tab (see 
page 80) after its transfer has been completed.
If there is a study which exceeded the period, the Warning screen will appear when the user logs 
off. Click [OK] to delete the study.

Logoff button
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5. Operations on study logs

The two types of study data below can be viewed through the Study Logs screen.
• Temporarily Saved: Study log data that is temporarily saved to the database in the control software
• Study Log Files: Study log data that was saved to a specified folder
Select the Temporarily Saved tab or Study Log Files tab to display the respective study logs.

5.1 Temporarily saved study logs
5.1.1 Displaying list of temporarily saved study logs

Click the Study Logs icon on the main screen (see page 41) and click the Temporarily Saved tab.
The study logs that were temporarily saved based on the conditions that were set in 7.11 Study Logs (see 
page 110) are displayed in a list.
The displayed items can also be set by making the settings in 5.1.6 Setting the display items (see 
page 36).

Study Logs screen (Temporarily Saved)

If the Study Trans Status has been set as an item to be displayed, the transfer status icons are is displayed.

Icon Status Description

None Untransferred A study which has not been transferred to any destination

Transfer A study which is being transferred

Transfer 
Completed A study whose transfer has been completed

Transfer Error A study which contains images whose transfer has failed
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5.1.2 Searching for studies

1 Display the Search screen.

Click [Search...] on the Study Logs screen (Temporarily Saved tab).

Search screen

2 Set the search conditions.

3 Proceed with the search.

Click [OK].
The search starts, and its results are displayed on the Study Logs screen.

Display Operation

Study Date Input the search start date on the left and the search end date on the right.
It is also possible to set only the start date or end date.

Item Click  to select the search item.

Keyword

Input a keyword consisting of up to 64 characters.
No distinction is made between upper-case and lower-case characters.
A search based on a keyword will not be conducted if no characters have 
been input.

[Default] When this is clicked, the 7.11 Study Logs (see page 110) setting is 
applied to the Study Date.

Number of displayed study logs in list
The maximum number of study logs that can be displayed in the list is 10,000. A flashing error icon 

 is displayed when the number of displayable study logs is exceeded, and so please change the 
search conditions. The error icon  disappears once the number of study logs is within the 
displayable range.
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5.1.3 Transferring studies
5.1.3.1 Selecting studies for transfer

When a study has been selected and [Transfer] clicked, the DICOM information will be updated in 
accordance with the settings of the 7.7.2 Study Logs tab (see page 99) except for those studies which 
are in the untransferred transfer status.

1 Select the study.

Click the study on the Study Logs screen (Temporarily Saved tab).
If a multiple number of studies are to be selected, click the studies while pressing the Ctrl key on the 
keyboard; if a range of studies is to be selected, click the studies while pressing the Shift key on the 
keyboard.

2 Transfer the studies.

Click [Transfer].
Transfer the study(ies) screen is displayed. Click [OK].
However, if the transfer status is “Transfer,” a Warning screen is displayed, and the study concerned 
cannot be transferred.

Transfer the study(ies) screen

Concerning the selection of the storages
When selecting the storage, refer to 4.5.1 Ending a study (see page 25).
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5.1.3.2 Transferring all studies

Take the steps below to transfer all the studies whose transfer status is transfer error or untransferred.

1 Transfer the studies in the transfer error status.

Click [Transfer All].
If there are studies whose transfer status is transfer error, the Re-Transfer Study(ies) of Failed 
Transfer screen will appear, in which case click [OK].
This screen will not appear if there are no studies whose transfer status is transfer error. Follow the 
sequence of steps described below.

Re-Transfer Study(ies) of Failed Transfer screen 

2 Transfer the to-be-transferred studies.

If there are studies whose transfer status is untransferred, the Transfer all the untransferred study(ies) 
screen will appear, in which case click [OK].

Transfer all the untransferred study(ies) screen

Concerning the selection of the storages
When transferring studies whose transfer status is Transfer Error, [Select Storage...] cannot be 
selected. 
If a multiple number of storages have been set, the studies will be transferred only to the storages 
to which transfer failed.

Concerning the selection of the storages
When transferring studies whose transfer status is untransferred, [Select Storage...] can be 
selected.
When selecting the storage, refer to 4.5.1 Ending a study (see page 25).
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5.1.4 Saving studies
When study log data was temporarily saved in the database of the control software, each study can be 
saved to a user-selected location.

Note: To save a study log data, access rights for the storage directory must be set.
For details, refer to (2) in 2.1 Software (see page 3).

1 Select the study.

On the Study Logs screen, select the study.
To select multiple studies, click the studies while holding down the Ctrl key on the keyboard. To 
select a range of studies, click the studies while holding down the Shift key on the keyboard.

2 Save the study to a designated folder.

Click [Save]. The Browse For Folder screen is opened.
Set the folder where the study will be saved, and click [OK].
The study is saved.

Browse For Folder screen

To cancel saving
To cancel saving of the studies, click [Cancel].
Once [Cancel] is clicked, the saving of unsaved studies is aborted, but studies where saving was 
completed or where saving was in progress are saved to the designated saving location.

Saving the study(ies) screen
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5.1.5 Deleting studies

1 Select the study.

On the Study Logs screen, select the study.
If a multiple number of studies are to be selected, click the studies while pressing the Ctrl key on the 
keyboard; if a range of studies is to be selected, click the studies while pressing the Shift key on the 
keyboard.

2 Delete the study.

Click [Delete]. The Warning screen is displayed, and the “Selected study will be deleted.” 
message is displayed. Click [OK] to delete the study.
However, if the transfer status is “Transfer”, a Warning screen is displayed, and the study concerned 
cannot be deleted.

5.1.6 Setting the display items

1 Display the Edit List screen.

Click [Edit List...].

Edit List screen

2 Set the items to be displayed.

To add or delete a display item, select the item, and then click  or .

3 Set the display sequence of the Displayed Items.

The items on the Displayed Items appear from the left of the list in sequence from the top.
To change the display sequence, select the item, and then click [Up] or [Down].

4 Enable the setting.

Click [OK].
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5.2 Study log file
The study logs that were saved to a selected location are displayed on the Study Log Files tab 
(see page 35).

5.2.1 Displaying study log files list

1 Display the Study Logs screen.

Click the Study Logs icon.

2 Select the study log file.

Click the Study Log Files tab.

Study Logs screen (Study Log Files tab)

3 Specify the location of the study log.

Click [Folder], and specify the location of the study log file in the Browse For Folder screen.
The folder location of the file(s) is displayed on the right side of the [Folder] button.

4 Specify the conditions for the studies to be displayed.

Click [Search], and set the conditions to be displayed such as the Study Date and Item in the Search 
screen.
For details, refer to 5.1.2 Searching for studies (see page 32).

Note: In the Study Logs screen of the Study Log Files list, the Transfer, Transfer All, Save, and 
Delete commands cannot be executed.

5.2.2 Deleting study logs

1 Display the folder of the study log file to be deleted in the Windows screen.

2 Select the folder of the study log file to be deleted, and press the Delete key.

Display items
Items set on the Edit List screen (see page 36) are displayed. However, the Transfer Completion 
Datetime and Study Trans Status are not displayed
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5.3 Study log screens
5.3.1 Displaying a study log screen

To display a study log screen, either click the study on the Study Logs screen (Temporarily Saved) (see 
page 31) or Study Logs screen (Study Log Files)  (see page 37) and then click [OK] or double-click the 
study.

Study log screen

What is displayed is basically the same as on the main screen: the differences from the main screen are 
described below.
• Images cannot be taken while the Study Logs screen is being displayed.
• The color of image toolbar, Patient Information, Study Information, Study Description, [Close] and 

[Transfer] are different.
• Some of the icons on the toolbar cannot be used.
• The study log screen can display only one study.
• On the temporarily saved study log screen,  is displayed on the study tab and the main image. On the 

Study Logs screen (Study Log Files),  is displayed on the study tab and the main image.
• [Study Cancel] on the main screen is replaced with [Close] on the past study screen; similarly, [Study 

Complete] on the main screen is replaced with [Transfer] on the study log screen.
• More photographs cannot be added to a study log.

Note: Following functions are not available on the study log screen for Study Log Files:
• Tranferring the studies (see page 33)
• Correcting the study descriptions (see page 23)
• Correcting the image comments (see page 46)
• QA (see page 65)
• Rejecting the images (see page 67)
• Correcting the patient information (see page 68)
• Measuring the C/D ratio (see page 54)
• Changing the study (see page 39)
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5.3.2 Changing study
When [Next Study] or [Previous Study] button is clicked while displaying a study log the next study or 
previous study is displayed in the listing order displayed in the study logs.

5.3.3 Study log screen and photography
New study information can be added even while the study log screen is displayed.  
However, photography is not possible on the study log screen.

Shortcut key operation
The same operation can be performed using the space bar (Next Study) and back space key 
(Previous Study) on the keyboard.

Study log viewing indicator
When a study log is opened, the position information is displayed as shown below.
Example: Denominator: Number of studies in the study log list

Numerator: Position of the opened study

Previous Study

Next Study
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5.3.4 Exiting the study log screen
5.3.4.1 Transferring the study and exiting the study log screen

Click [Transfer].
The Transfer the study(ies) screen is displayed. Click [OK].
However, if the transfer status is “Transfer,” a Warning screen is displayed, and the study concerned cannot 
be transferred.

Transfer the study(ies) screen

When the studies are transferred, the DICOM information will be changed in accordance with the settings 
of the 7.7.2 Study Logs tab (see page 99) except for those studies which are in the untransferred 
transfer status.

5.3.4.2 Exiting the study log screen

Click [Close].
The Close a study log screen is opened. Click [OK].

Close a study log screen

Concerning the selection of the storages
When selecting the storages, refer to 4.5.1 Ending a study (see page 25).

[Transfer] and [Close] for past studies
The same operations can be performed by selecting [Study] > [Close] and [Study] > [Transfer] 
from the menu bar.
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6. Main screen operations

6.1 Main screen
6.1.1 Toolbar

Toolbar
Icon Icon name Reference chapter and page

Study 4.2 Inputting the study (see page 10)

Color
4.4 Taking images (see page 23)

Photography ready lamp

Main and Thumbnails

6.2 Image display methods and properties (see page 44)

Two-Row Thumbnails

Thumbnails Only

By Time

By R/L

Compare Studies 6.4 Comparing studies (see page 52)

Stereo View 6.6 Stereo view (see page 58)

C/D Ratio 6.5 Measuring C/D ratio (see page 54)

Easy PhotoPrint EX or 
Print 6.7 Printing images (see page 60)

QA 6.8 QA (see page 65)

Reject 6.9 Rejecting images (see page 67)

Previous Study
5.3.2 Changing study (see page 39)

Next Study

Toolbar
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6.1.2 Display information

Image toolbar

Display information

Study Logs 5. Operations on study logs (see page 31)

Logoff 3.2 Exiting the software (see page 8)

Icon Icon name Reference chapter and page

Icon Icon name Reference chapter and page

RGB Channels
6.3.2 RGB channel view (see page 49)

Normal View

Contrast/Brightness
6.3.3 Contrast/brightness adjustment (see page 50)

Reset Contrast/Brightness

Loupe 6.3.4 Enlarging an area of the image (Loupe) (see page 51)

Hand 6.3.5 Moving the displayed area (see page 51)

Image Property 6.2.2 Referencing the image properties (see page 45)

Zoom Out

6.3.1 Zooming (see page 48)Zoom In

% Display Mognification

Screen area Reference chapter and page
Study tab 4.2.1 Methods of inputting the study (see page 10)

Thumbnail image 7.9.2 Thumbnail Image Info. tab (see page 103)
7.9.4 Thumbnail Order tab (see page 105)

Main image 7.9.1 Main Image Info. tab (see page 102)
Patient Information

7.9.3 Study Info. tab (see page 104)
Study Information
Study Description 4.4 Taking images (see page 23)

Thumbnail image

Main image

Patient Information

Study Information

Study Description

Study tab

Image toolbar
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6.1.3 Menu bar

Menu Reference chapter and page

File

Change a Password 6.12 Changing the password (see page 71)
Print Adjustment 6.7.1 Adjusting the printing parameters (see page 60)
Print

6.7.2 Using simple printing to print images (see page 61)
Page Setup
Easy-PhotoPrint EX 6.7.3 Using Easy-PhotoPrint EX to print images (see page 63)
Save As 6.11.1 Save as (see page 69)
JPEG Settings 6.11.2 JPEG settings (see page 70)
Logoff 4.6 Logging off (see page 29)

Edit Select All All the images are selected.

View
Hide Rejected Images

6.2.1 Selecting the display method (see page 44)
Hide Study Information
Stereo View 6.6 Stereo view (see page 58)

Patient Change a Patient 
Information 6.10 Changing the patient information (see page 68)

Study

Study  F1 4.2 Inputting the study (see page 10)
Skip Study Input F5 4.3 Starting a study without opening the Study Input screen (see page 22)
Study Cancel

4.5.1 Ending a study (see page 25)
Study Complete F12
Set Auto Numbering 7.5.2 Manual Input tab (see page 83)
Close 5.3.4 Exiting the study log screen (see page 40)
Transfer 5.1.3 Transferring studies (see page 33)

Help Version 6.13 Displaying the version information (see page 72)



6. Main screen operations

-44-

6.2 Image display methods and properties
6.2.1 Selecting the display method

1 Click the image display icon.

1) Main and Thumbnails icon
The thumbnails are displayed at the top of the screen. When a thumbnail display is clicked, its 
enlarged image is displayed at the bottom of the screen.

Main and Thumbnails display

2) Two-Row Thumbnails icon
Images are displayed in two columns.

Two-Row Thumbnails display

3) Thumbnails Only icon
Thumbnails of images are displayed.

Thumbnails Only display
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2 Change the sequence in which the images are to be displayed.

When displaying the images in the sequence in which they were taken, click the By Time icon; when 
displaying the images in the sequence of the left and right eyes, click the By R/L icon.

6.2.2 Referencing the image properties
When the main and thumbnail display has been selected, the properties of image can be referenced.

1 Select the main and thumbnail display.

Click the Main and Thumbnails icon.

Main and thumbnail display

2 Select the image.

Click the thumbnail image.

Turning display of the study information screen on and off
On the menu bar, click [View] > [Hide Study Information] to turn the display of the study 
information screen on and off.

Turning display of rejected images (see page 67) on and off
On the menu bar, click [View] > [Hide Rejected Images] to turn the display of rejected images 
on and off.
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3 Display the Image Property screen.

Click the Image Property icon.

4 Input comments for the image.

Input comments in the Image Comments field. A description consisting of up to 4096 characters can 
be input.
Different image comments for different images can be saved.
For a study log file, image comments cannot be edited.

5 Display the item.

Select and double-click the name of the item whose value is to be referenced.
The item display screen is displayed.
The screen is exited when [Close] is clicked.

Item display screen

Setting of the Image Comments
For details on the image comments saved on DICOM images, refer to 7.7.1 Study tab (see 
page 97).
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6 Exit the Image Property screen.

Click [OK].
However, [OK] cannot be clicked if the image comments have not been changed, in which case click 
[Cancel].
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6.3 Image operations
6.3.1 Zooming

When the main & thumbnail display has been selected, Zoom In icon and Zoom Out icon can be used.

1 Select the main & thumbnail display.

Click the Main and Thumbnails icon.

Main & thumbnail display

2 Select the image.

Click the thumbnail image.

3 Change the display magnification rate.

Click the Zoom Out icon  or Zoom In icon .

Zoom in/zoom out operations
Each time the mouse is clicked, the image is zoomed in or out.
The initial display shows the minimum size. When the magnification rate is 100%, the image 
cannot be zoomed in any further.
The image can also be zoomed in and out by selecting the main image and turning the mouse 
wheel.
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6.3.2 RGB channel view
The color components (R, G, B) of the color image can be displayed separately.

1 Select the image.

Click the thumbnail image.

2 Display the RGB split images.

Click the RGB Channel icon.
In addition to the color image, the R (red), G (green), and B (blue) color component images are also 
displayed.
To restore to the original display, click the Normal View icon.

RGB channel view

Available image operations on RGB channel view images
The following image operations are available on RGB channel view images.
• Zooming (see page 48)
• Contrast/brightness adjustment (see page 50)
• Moving the displayed area (see page 51)
Whenever the zooming in/out and moving operations are used, they are applied to all split-screen 
images.

Display of the Reject and Study Logs icons
The Reject and Study Logs icons are displayed for color images only.

Green component

In color

Red component

Blue component
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6.3.3 Contrast/brightness adjustment
The contrast and brightness of the main image can be adjusted.

1 Select the image.

Click the thumbnail image.

2 Adjust the contrast or brightness.

Click the Contrast/Brightness icon.
The adjustment cursor is displayed. While the left-mouse button is held down, the contrast value (C) 
and brightness value (B) are displayed at the top right of the image. 
Perform the operation below while holding down the left-mouse button. 

Adjustment item Operation

Brightness Move up: Brightness increases.
Move down: Brightness decreases.

Contrast Move to right: Contrast increases.
Move to left: Contrast decreases.

Images where contrast or brightness were adjusted
To return to the image before adjustment, click the Reset Contrast/Brightness icon. The 
adjustment value is reset when the study is closed.
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6.3.4 Enlarging an area of the image (Loupe)
A part of an image can be enlarged for display.

1 Select the image.

Click the thumbnail image.

2 Enlarge a part of an image for display.

Click the Loupe icon, and then click over the main image with the mouse.
To move the enlargement position, move the mouse while holding down the left-mouse button.
To restore to the original image, release the left-mouse button.
To return to the original pointer, click the Hand icon.

Enlarged display

6.3.5 Moving the displayed area
The displayed area of an enlarged image can be moved in the main image.

1 Click the Hand icon.

2 Move the mouse over the main image that is being enlarged while holding down the left-

mouse button.

Enlargement display size and magnification rate
The displayed size and magnification rate are determined by the settings on the Loupe tab. See 
7.9.5 Loupe tab (see page 106) for details.



6. Main screen operations

-52-

6.4 Comparing studies
A comparison view of studies can be displayed.

1 Open a study to be compared.

To compare with a current study, click the Study tab.
To compare with a study log, click the Study Logs icon, select from the Temporarily Saved list or 
Study Log Files list, and click [OK].

2 Select the image.

Click the thumbnail image.

3 Display the Compare Studies screen.

Click the Compare Studies icon.
The same screen is displayed on the right and left.

4 Display the study logs.

Click the Study Logs icon.

5 Select the study log and display an image of the study log.

Select the study log from the list, and click [OK].
The selected study log is displayed on the right side of the Compare Studies screen.
To change the study log that is compared, repeat the steps 4 and 5. The study displayed on the right 
side is replaced.
Studies cannot be displayed unless they are saved.

 

Compare Studies screen 

Note: Images cannot be taken when the Compare Studies screen is displayed.
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6.4.1 Image display icon

6.4.2 Displayed item setting
The displayed items for the study information can be specified.
Click [Edit List] to display the Edit List screen.
The items where the display setting can be made are the same as the items that can be displayed in the 
Study Information screen of the main screen.
For details about the setting procedure for the setting items, refer to 7.9.3 Study Info. tab (see 
page 104).

Icon Icon name Function

Main, Thumbnails, 
and Study 
Information

The main and thumbnail images are displayed together with the 
study information.

Main and 
Thumbnails

The main and thumbnail images only are displayed, and the study 
information is not displayed.

Thumbnails and 
Study Information The thumbnails are displayed together with the study information.

Thumbnails Only The thumbnails only are displayed.

By Time The images are displayed in the order that they were taken.

By RL The images are displayed in the order of the left/right eye.

Move/Apply Effects 
to Both Images

When this option is enabled, an operation applied to the right or left 
image is applied to the other. 
When the display is switched between RGB view and normal view,  
or zoom in and zoom out button operations are performed for one 
of the image, same operation is applied to the other.
Application of an operation to both images is canceled when one 
of the following operations is performed.
• Selecting another image
• Canceling selection of an image
• Opening a different study

Study Logs Study log is opened, and the selected study is displayed at right 
side.

Menu item Submenu Description

View

Hide Rejected 
Images The rejected images display can be turned on or off.

Hide Study 
Information The study information screen can be turned on or off.
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6.5 Measuring C/D ratio
The cup-to-disc ratio of the optic nerve papillary area from the image can be measured. Two methods are 
available: finding the area ratio and finding line ratio.

Note: Photography is not possible on the C/D Ratio screen.

6.5.1 Displaying the C/D ratio enlarge screen

1 Select the image.

Click the thumbnail image.

2 Open the C/D Ratio screen.

Click the C/D Ratio icon on the main screen.

3 Enlarge the image.

Move the mouse to the center of the optic nerve papillary area with the enlargement cursor displayed, 
and then click.
The image is enlarged with the clicked location as the center.
To move the image area, use the Hand icon or scroll bar.

C/D Ratio enlarge screen

Button and display item Description

[Area Ratio] Check this item to select the area ratio drawing mode.

[Line Ratio] Check this item to select the line ratio drawing mode.

Line Ratio combo box Check this item to select a line drawn in a line ratio. Select Vertical 
Line or Optional.

[Disc] Press this button to perform the disc drawing.

Disc color label Click this item to display the color setting screen.
The line color of the disc drawing can be set.

[Reset] for Disc Press this button to reset the disc drawing.

[Cup] Click this item to display the color setting screen.
The line color of the cup drawing can be set.

Color labels
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6.5.2 Measuring area ratio
Closed curve on the image can be drawn to measure the area ratio of the disc and cup.
To measure the line ratio, refer to 6.5.3 Measuring the line ratio (see page 57).

1 Select the drawing mode of the area ratio.

Click [Area Ratio].

2 Select the disc drawing.

Click [Disc].

3 Draw a disc.

Click the starting point.
The drawing is made with the display color that was preset for the color label. 

4 Click the mouse to plot at least three points at the desired plotting locations.

Finally, double-click at the last point, or select [Form a Shape] from the right-click menu. A closed 
curve is connected in the order of the plotted points, and a drawing resembling a disc shape is 
displayed.

Cup color label The line color of the disc drawing can be set.

[Reset] for Cup Press this button to reset the cup drawing.

Area The area C/D ratio that is drawn in an area ratio is displayed here.

Vertical The vertical C/D ratio that is drawn in the area ratio is displayed 
here.

Horizontal The horizontal C/D ratio that is drawn in the area ratio is displayed 
here.

Line The line ratio is displayed here. Line and Vertical are used 
together, and so separate values cannot be left.

[OK] 

Press this button to save the C/D ratio and close the screen.
The drawn color of the cup and disc are saved.
The drawing mode that was selected with Area Ratio and Line 
Ratio is also saved.

[Cancel] Press this button to close the screen.

Mouse cursor Name Description

Draw cursor This icon is displayed during draw mode of C/D 
ratio. 

Initial enlargement 
cursor

When C/D ratio is opened, this is displayed when 
enlarging by clicking the mouse.

Button and display item Description

Canceling the point that was just selected
Press the Backspace key during drawing to cancel the point that was just selected.
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5 Draw a cup.

Select [Cup] and draw using the same procedure for Disc.

6 Reshape the disc or cup.

After drawing is completed, the shape can be adjusted.
If the pointer is brought close to the clicked point, the color of the point changes to gray.
The point can be dragged to move it to another location. However, it cannot be moved over points 
that are already plotted.
To edit the drawn line, right-click over a point or line.
A red point is displayed on the line.

7 The C/D ratio is displayed.

Even when reshaping of a cup or disc, the C/D ratio is calculated and displayed to two decimal 
places.
In images where it is already calculated, the previously-calculated value is displayed.

8 Save the values and exit the measurement.

Click [OK].
The Cup and Disc drawing colors and measurement values of the C/D ratio are saved, and the screen 
is closed.

Note: Drawing information (points and lines) for the Area and Line ratio measurement will be lost 
when the C/D Ratio screen is closed.

Right-click menu item Description

Form a Shape Select this item to connect the points and draw a closed curve.

Insert the Dot Select this item to insert a new point and reshape the drawing.

Delete the Dot Select this item to delete a selected point and reshape the drawing.

Display item Description

Area Ratio of the cup area and disc area

Vertical Ratio of the heights when drawing is bound by a rectangle

Horizontal Ratio of the widths when drawing is bound by a rectangle
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6.5.3 Measuring the line ratio
The line ratio can be measured by drawing a vertical line or straight line.

1 Display an enlarged screen from the CD ratio screen.

2 Insert a check mark in [Line Ratio], and select a vertical line or straight line.

3 Select [Disc] or [Cup].

4 Click the start point of the drawing on the screen.

5 Click at the location of the second point.

The drawing is completed when the second point is clicked.
A straight line is drawn connecting the start point and second point position.

6 If necessary, edit the line.

After the cup and disc drawing is complete, the line can be edited.
Place the pointer over the point. The editing can be performed while the color of the point changes.

7 When the drawing of Cup or Disc is completed, the C/D ratio is calculated and displayed.

The value is displayed in the Line under the Line Ratio.
Click [OK].
The Cup and Disc drawing colors and measurement values of the C/D ratio are saved, and the screen 
is closed.

Note: Drawing information (points and lines) for the Area and Line ratio measurement will be lost 
when the C/D Ratio screen is closed.

Canceling the point that was just selected
Press the Backspace key during drawing to cancel the point that was just selected.

Item Operation C/D ratio line

Vertical Line

Drag a point up or down to change the position 
of the point.
Drag a point to the right or left to move the line 
from side to side.

Ratio of Cup vertical line and 
Disc vertical line

Straight Line Drag a point to move the point freely in any 
direction.

Ratio of Cup straight line and 
Disc straight line
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6.6 Stereo view
Two images that were taken in the same shooting mode are displayed side by side.

1 Select the images.

Select the two thumbnail images by clicking them while holding down the Ctrl key on the keyboard.

2 Open the Stereo View.

Click [Stereo View] in the toolbar, or click [View] > [Stereo View] from the menu bar.
Images cannot be taken while the Stereo View screen is being displayed.

Stereo View screen

3 Adjust the image.

Use the image operation icons and image toolbar to adjust the images.

Image operation 
icon/button

Name Function

<- -> Select this item to switch the right and left 
images.

Move/Apply Effects to 
Both Images

This function is enabled when the Stereo 
View screen is opened.
When operation such as moving the 
displayed area, zoom in/out or changing the 
magnification rate is performed on the left 
image, the same effect that was applied to 
the left image is also applied to the right 
image. Operations are performed 
independently on the right and left images 
when this function is disabled.

Contrast/Brightness
6.3.3 Contrast/brightness adjustment 
(see page 50)Reset Contrast/

Brightness
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4 Exit Stereo View.

Click [Close].
The Stereo View information below is recorded when the Stereo View screen is closed:
• Display image position
• Size

Hand 6.3.5 Moving the displayed area (see 
page 51)

Reduce

6.3.1 Zooming (see page 48)Enlarge

% Display Magnification

Image operation 
icon/button

Name Function
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6.7 Printing images
Images can be printed out using the 7.10 Print (see page 109) settings.
The available printing methods are simple printing and Easy-PhotoPrint EX.
Before printing the images, set the printing parameters.

6.7.1 Adjusting the printing parameters
Printing parameters for images can be adjusted.
The adjustment here are applied only when images are printed, and will not be applied to the parameters of 
the images themselves.
When the parameters of the images themselves are to be changed, refer to 6.8 QA (see page 65).

1 Select the image.

Click the thumbnail image.

2 Display the Print Adjustment screen.

On the menu bar, click [File] > [Print Adjustment...] in this order.

Print Adjustment screen

3 Adjust the parameters.

The adjusted parameters are applied to all the images in the retinal camera mode which has been 
selected.

Parameter Operation

Contrast Any contrast level from -50 to 50 can be set.
Drag the slider or click  or .

Brightness Any brightness level from -50 to 50 can be set.
Drag the slider or click  or .

Gamma Any gamma level from -1.00 to 1.00 can be set.
Drag the slider or click  or .

Hue (R)
Any hue level from -50 to 50 can be set.
Drag the slider or click  or .Hue (G)

Hue (B)
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4 Save the settings.

Click [OK].

6.7.2 Using simple printing to print images
The simple printing function of the control software is used to print images with the printing parameters 
that were adjusted in 6.7.1 Adjusting the printing parameters (see page 60).

1 Turn on the power of the printer.

2 Select the image.

Click the thumbnail image.
To select multiple images, click the images while holding down the Ctrl key on the keyboard. To 
select a range of images, click the images while holding down the Shift key on the keyboard.

3 Open the Page Setup screen.

On the menu bar, click [File] > [Page Setup...] in this order.

Page Setup screen example

4 Set the paper size, printing orientation, margin, printer, and other parameters.

Setting values
When starting this software, the setting values for the default printer are used.
If the paper, printing orientation, and printer settings are changed, the only setting value saved after 
restarting is the margin setting.
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5 Proceed with the printing.

On the File menu bar, click [File] > [Print] in this order.
When the Print screen is displayed, click [Print] button.
The output of the selected image and Print information to the printer is started.
The screen returns to the original window after image output to the printer is completed.

Print screen

Print information

Simple printing with the Print icon
To print using simple printing when clicking the Print icon, remove the check mark from the Print 
with Easy-PhotoPrint EX option in the print settings (see page 109).

Items Details

Patient ID “ID:” is added at the start.

Patient Name This is printed with separators “^” added between data entry items in the 
following order: Last Name^First Name^Middle Name^Prefix^Suffix.

Accession No. “No.:” is added at the start.

Right/Left R, L

Study Date OS short date format + Space + H:mm:ss
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Print layout example

6.7.3 Using Easy-PhotoPrint EX to print images 
The images are printed using Easy-PhotoPrint EX with the printing parameters that have been adjusted in 
6.7.1 Adjusting the printing parameters (see page 60).

Note: To print with Easy-PhotoPrint EX, install the software in advance.

1 Turn on the power of the printer.

2 Select the image.

Click the thumbnail image. 
If a multiple number of images are to be selected, click the images while pressing the Ctrl key on the 
keyboard; if a range of images is to be selected, click the images while pressing the Shift key on the 
keyboard.

Printing information
If a part of printing information item cannot be laid out in the provided space, ellipsis (...) are shown 
before the Patient ID and Accession No. and after the Patient Name and Study Date to indicate that 
information is omitted. The number of possible output characters varies depending on the paper size, 
paper orientation, and margin settings.

Accession No. Study DatePatient ID

Patient Name

Right/Left
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3 Open the Easy-PhotoPrint EX screen.

On the File menu bar, click [File] > [Easy-PhotoPrint EX] in this order.
The selected image is displayed as the printing image.

Easy-PhotoPrint EX screen

4 Set the Select Images tab.

On the Select Images tab, click the image.

5 Set the Select Paper tab.

Click the Select Paper tab, and click the Paper Size and Media Type.

6 Set the Layout/Print tab.

Click the print layout.

7 Proceed with the printing.

Click the Print button.
After printing is completed, click the Exit button.
The Easy-PhotoPrint EX window closes, and the control software screen is restored.

Note: Printing may be aborted automatically when trying to print large spool size images or when 
there is little available hard disk space. In this case, no error message is displayed.
To print large spool size images, click [File]>[Preferences...] on the Easy-PhotoPrint EX 
screen.
Next, open the Print tab of the Preferences screen, and add a check mark to “Spool print 
job page by page” option and perform printing.

Printing with the Print icon
To print using Easy-PhotoPrint EX when clicking the Print icon, add a check mark to the Print with 
Easy-PhotoPrint EX option in the print settings (see page 109).
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6.8 QA
Take the steps below to adjust the images.

1 Select the image.

Click the thumbnail image.

2 Display the QA (Quality Assurance) screen.

Click the QA icon.

QA (Quality Assurance) screen

3 Set the parameters.

If the parameters have been saved, click Parameter Set , and click the name of the parameter set 
from the list shown.
To set a new parameter, refer to the table below, and set it.

Parameter Operation

Contrast Any contrast level from -100 to 100 can be set.
Drag the slider or click  or .

Brightness Any brightness level from -150 to 150 can be set.
Drag the slider or click  or .

Gamma Any gamma level from 0.01 to 3.00 can be set.
Drag the slider or click  or .

Hue (R)
Any hue level from -100 to 100 can be set.
Drag the slider or click  or .Hue (G)

Hue (B)

Coordinate Hues
When this is checked, as soon as the value of one of the hues is changed, 
the values of the other two hues will also be changed so that the sum total 
of the values will be zero.

[Restore Defaults] When this is clicked, the current parameters are set to the default values 
for the retinal camera mode of the adjusted images.[Set as Default]
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4 Apply the setting.

Click [Apply to Selected Images]. The screen now closes, and the parameter is applied.

Maintenance of the parameter set
To save a new parameter set, enter the name in the Parameter Set column using up to 32 
characters, and click [Add].
To delete an already saved parameter set, click the name of the Parameter Set, and click [Delete].
In cases where an already saved parameter set has been selected and then changed, click 
[Update] to overwrite the existing parameter set with the current setting or click [Undo] to return 
to the saved setting.
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6.9 Rejecting images
Images set to be rejected are not transferred.
All other operations can be performed as usual.

1 Select the image.

Click the thumbnail image.

2 Set the image to reject.

Click the Reject icon. A red “×” will appear at the bottom right of the thumbnail and main images.
When the Reject icon is clicked again, the red “×” is cleared and the rejection is canceled.

Image to be rejected

Image rejection operation
The image rejection operation cannot be performed if [View] > [Hide Rejected Images] is selected 
from the menu bar to hide the rejected images.
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6.10 Changing the patient information
The patient information input manually or with a magnetic card or barcode reader can be changed.
The patient information acquired by the list or worklist input cannot be changed.

1 Display the Patient Info Edit screen.

On the menu bar, click [Patient] > [Change a Patient Information...] in this order.

Patient Info Edit screen

2 Input the patient information.

For details on the input information, refer to inputting the study information (see page 11).
In this case, there is no Study Description.

Note: In the Patient Info Edit screen, the Essential Data, Input-Disabled Data and Input Format 
settings in the Manual Input tab settings (see page 83), and the Essential Data setting in 
the Mag Barcode Input tab (see page 86) are disabled. Please use care when editing the 
patient information in this screen.

3 Change the patient information.

Click [OK].
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6.11 Saving as JPEG files
The images displayed on the main screen can be saved as JPEG files.

6.11.1 Save as

1 Select the image.

Click the thumbnail image.

2 Display the save screen.

Click [File] > [Save As...] from the menu bar.
The Save As screen is now displayed.

3 Select the file name, file type and folder where the image will be saved.

The default settings are given below.

4 Save JPEG file.

Click [Save].

Setting item Description

File name
“Format”

Date + time
“yyyyMMddhhmmssfff.jpg”
(year/month/day/hours/minutes/seconds/milliseconds when the selected 
file was displayed on the Save As screen)

Save as type Jpeg files (*.jpg)

Save in
(Folder where the 
image will be saved)

Windows XP: “My Pictures”
Windows Vista: “Pictures”
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6.11.2 JPEG settings

1 Display the JPEG Settings screen.

Click [File] > [JPEG Settings...] from the menu bar.
The JPEG Settings screen is displayed.

JPEG Settings screen

2 Set the JPEG Quality and Resize settings for the JPEG files.

3 Apply the settings.

Click [OK].

Input item Operation

JPEG Quality Input a number from 1 to 100.  “100” represents the highest quality.

Resize
(with fixed aspect 
ratio)

Check this to change the image size while keeping the aspect ratio fixed.

[Ratio]
Input a number from 1 to 100 to specify to what percentage 
the width and height of the images are to be reduced from 
the original.

[Size (Width)] Click the width of the image after reduction, and select.
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6.12 Changing the password
Take the steps below to change the password of the user who is currently logged in.

1 Display the Change a password screen.

On the menu bar, click [File] > [Change a Password...] in this order.

Change a password screen

2 Input the password.

Input no more than 16 characters for the Current Password, New Password and New 
Password(confirm).

3 Change the password.

Click [OK].
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6.13 Displaying the version information
On the menu bar, click [Help] > [Version] in this order. The Version Information screen is displayed.

Version Information screen
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7. Settings

7.1 Settings Menu screen
On the login screen, input the User ID and Password with which the Privilege (see page 100) has been 
set to the Administrator, and click [Settings].  The Settings Menu screen is displayed.
To exit the Settings Menu screen, click [Close].

Settings Menu screen

Icon name Setting contents Reference chapter and page

System Used to perform the settings for the 
DICOM information and image output. 7.2 System (see page 74)

Device Used to perform the settings for the 
retinal camera and digital camera. 7.3 Device (see page 77)

Study 
Management

Used to perform the settings for image 
saving. 7.4 Study Management (see page 80)

Study Input Used to perform the settings for the study 
input. 7.5 Study Input (see page 82)

Storage Used to set the output destination of the 
images. 7.6 Storage (see page 92)

DICOM Tag Used to perform the settings for the 
DICOM information. 7.7 DICOM Tag (see page 97)

User Accounts Used to set the user information. 7.8 User Accounts (see page 100)

Screen Used to perform the settings for the 
information displayed on the screen. 7.9 Screen (see page 102)

Print Used to set the printing method. 7.10 Print (see page 109)

Study Logs List Used to set the search target date on the 
study logs list. 7.11 Study Logs (see page 110)

Magnetic Card/
Bar Code

Used to perform the settings for the 
magnetic cards and barcodes.

7.12 Magnetic Card/Bar Code (see 
page 110)
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7.2 System
The System screen is displayed when the System icon is clicked.
Click the tabs, and set the parameters.
To save the settings and exit the System screen, click [OK].

System screen

7.2.1 System tab
Used to perform the settings for the DICOM information.

System tab

Item Operation

SOP Class Click , and select SOP Class from the list.

Modality

This is displayed automatically in accordance with the SOP class setting.
VL Photographic Image Storage: XC
Secondary Capture Image Storage: OT
Ophthalmic Photograhy 8 Bit Image Storage: OP

AE Title Input no more than 16 characters. (Required)
The backslash (\) cannot be input.
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7.2.2 Transfer Timing tab
Select the timing at which the images are to be transferred.

Transfer Timing tab

Station Name Input no more than 16 characters.
The backslash (\) cannot be input.Location

Institutional 
Department Name Input no more than 64 characters. (Required)

The backslash (\) cannot be input.
Institution Name

Item Operation

Item Operation

When a study is 
completed

When a study is completed, images are automatically output to the 
storages which has been set in 7.6 Storage (see page 92).

Manual
When a study is completed, images are not automatically output.
When outputting the images, refer to 5.1.3 Transferring studies (see 
page 33).
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7.2.3 Specific Character Set tab
Click  to set the specific character set used for study input and DICOM communication.
The values corresponding to the selected item are used in Specific Character Set (0008,0005).

Specific Character Set tab

Item Specific character set tag value

Default None

Latin-1 ISO_IR 100

Latin-2 ISO_IR 101

Cyrillic ISO_IR 144

Greek ISO_IR 126

Latin-5 ISO_IR 148

Japanese <katakana> ISO_IR 13

Japanese <kanji> \ISO 2022 IR 87

Japanese <kanji + katakana> ISO 2022 IR 13\ISO 2022 IR 87

Japanese <kanji + katakana 
(code extension)> \ISO 2022 IR 13\ISO 2022 IR 87

Japanese <katakana (code 
extension)> \ISO 2022 IR 13

Setting of specific character sets
The setting for the specific character set needs to be made to match the connected system and 
language keyboard that is used. English OSs do not support Japanese input.
If transfer is performed from a study log after changing the setting, the setting is not applied. In 
DICOM transfer, the specific character set designated during study is used.
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7.3 Device
The Device screen is displayed when the Device icon is clicked.
Click the buttons to display the setting screens.
To save the settings and exit the Device screen, click [Close].

Device screen

7.3.1 Retinal Camera Settings
The Retinal Camera screen is displayed when [Retinal Camera] is clicked.

Retinal Camera screen

1 Set the COM Port.

Click  or , and select a number from 1 to 16 for the port where the connection has been made 
with the retinal camera.
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2 Check the connection with the retinal camera.

Click [Connection Check...].
If the connections have been made properly, the Result of Retinal Camera Connection screen is 
displayed.
When [OK] is clicked, the Result of Retinal Camera Connection screen is closed.

Result of Retinal Camera Connection screen

3 Save the settings.

On the Retinal Camera screen, click [OK].

7.3.2 EOS Settings
The EOS screen is displayed when [EOS] is clicked.
Depending on the conditions, some parameters cannot be selected. For details on the parameters, refer to 
the instruction manual of the digital camera.

EOS screen

When an Error screen has appeared
When an Error screen has appeared, check the following.
• Is the power of the retinal camera on?
• Are the retinal camera and computer connected correctly?
• Has the port number been set correctly?
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1 Perform the EOS settings.

2 Check the connection with the EOS.

Click [Connection Check...].
If the connections have been made properly, the Information screen is displayed.
When [OK] is clicked, the Information screen is closed.

Information screen

3 Save the settings.

On the EOS screen, click [OK].

Item Operation

Model Click , and select the digital camera being used.

Retinal Camera 
Mode Color only can be selected.

Grayscale 
Conversion Select Yes or No.

Image Format Select JPEG or RAW.

Image Size
Select the image size.
The available image sizes vary depending on the image format and ISO 
speed.

Image Quality Select Fine or Normal.
The available image resolutions vary according to the image format.

ISO Speed
Select the ISO speed.
Select 3200 (LOW1) or 1600 (LOW2) for the low flash intensity 
photography.

Picture Style Select Picture Style.

When an Error screen has appeared
When an Error screen has appeared, check the following.
• Is the power of the retinal camera on?
• Is the power of the digital camera on?
• Are the retinal camera and computer connected by a cable?
• Are the digital camera and retinal camera connected by a cable?
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7.4 Study Management
The Storage tab of the Study Manager screen is displayed when the Study Management icon is clicked.
On this tab, the storage directory of the images and the save period are set.
To set the storage directory which the images are to be exported as the DICOM or JPEG format file, refer 
to 7.6 Storage (see page 92).

Study Manager screen (Storage tab)

1 Set storage directory.

Item Operation

Image Storage 
Directory 
(Folder)

Click [Browse...], open the Browse For Folder dialog box, and set the folder 
into which the work data is to be saved.
Removable disks and network-related folders cannot be set.
In Windows Vista, set access privileges for the saving folder if necessary. 
(Refer to (2) in 2.1 Software (see page 3).)

Display warning 
when available 
drive size is less 
than

When this is checked, an Warning screen will be displayed when the amount 
of free space on the hard disk has fallen below the setting.
Click  or  to select a setting from 5 to 999.
The amount of free space on the hard disk is checked in the following 
circumstances:
• When [Browse...] has been clicked and a folder selected
• When [OK] has been clicked on the Study Manager screen
• When the New Study icon has been clicked on the main screen
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2 Check the amount of free space.

Click [Check Remaining Capacity...].
The Information screen is displayed, and the amount of free space on the hard disk is displayed.
When [OK] is clicked, the Information screen is closed.

Information screen

3 Set the save period.

The save period is the number of days that the study (study information and images) are saved on the 
computer after the study (study information and images) is transferred to the DICOM storage server 
or exported as the DICOM or JPEG format files.
Click  or , and select a setting from 0 to 999.

4 Save the settings.

On the Study Manager screen, click [OK].

Concerning the amount of free space required on the hard disk 
An Error screen will be displayed if there is less than 1 GB of free space on the hard disk 
containing the folder which has been set for the storage directory.
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7.5 Study Input
When the Study Input icon is clicked, the Study Input/MPPS Modules screen is displayed.
Click the tabs, and set the parameters.
To save the settings and exit the screen, click [OK].

Study Input/MPPS Modules screen

7.5.1 Module Settings tab
On this tab, the study input module and study input screen switching settings can be made.

1 Select the study input modules from the module list.

Add a check mark to the status check box.
The selected module tabs are added in the order of the check marks.

Module Settings tab
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2 Select the operation of the Study Input screen when a study ends.

When “Open Study Input screen when a study is closed” is checked, the screens change as 
shown below.

7.5.2 Manual Input tab
When entering patient information manually (see page 11) in the Study Input screen, set essential input 
data, input-disabled data, the method for entering birth date data and the input format.

Manual Input tab

1 Set the Essential Data, Input-Disabled Data, Birth Date Input, and Input Format.

 Assign Accession No. 
automatically 
(see page 85)

Screen switching

When enabled After the taking of images or the study is ended, the Study screen is 
closed, and the Study Input screen is automatically opened.

When disabled

After the taking of images or the study is ended, the Study screen is 
closed, then when the Study icon is clicked in 4.2 Inputting the 
study (see page 10), the Study Input screen for the module entered 
last is opened.

Item Operation

Essential Data
Check the items which are to be set as the essential input data.
The item names of items set as the essential input data turn blue on the Study 
Input screen.

Input-Disabled 
Data

Check items to prohibit inputting.
The Essential Data setting is canceled for the items checked here.

Birth Date Input

Click , and select the birth date input method.

Fill in a Box with 
Separator

To input the year, month and day using / (slashes) into 
one box.

Fill in Separate 
Boxes To input the year, month and day into separate boxes.
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Note: The check for input format is valid in the Manual Input screen only. No check for input 
format is made in the Patient Info Edit screen or in the Study Description input section of 
the Study screen. 
Therefore, be careful when editing patient information after a study is started.

Input Format 
(Input item 
settings)

Check the items to set the input format.

Patient ID Specify the length, input character type, header 
character string, and digit filling characters.Accession No.

Patient Name Select the input character type.

Study 
Description

Specify the input character type and header character 
string.

Input Format

Length

Specify the length of the input character string.
Input the Patient ID in 64 characters or less and the 
Accession No. in 16 characters or less. If nothing is 
entered, the Patient ID has a length of 64, and the 
Accession No. has a length of 16.

Acceptable 
Character Set

Click  to select the available character type from the 
list.

Header string

Specify the character string added to the left side of 
input values.
Input the Patient ID and Study Description in 64 
characters or less, and input the Accession No. in 16 
characters or less. (The backslash (\) cannot be input in 
either one.)

Filler Character Specify the character that is added to an input character 
string when it is less than the specified length.

When a check mark is inserted for Patient Name as an essential item
If a check mark is inserted for Patient Name as an essential item, the Setting Details screen will 
open.
Insert a check mark for Last Name and/or First Name.
The item with a check mark is displayed in blue on the Study Input screen.

Item Operation
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2 Make the setting for the Automatic Accession No. Assignation menu.

To use the Automatic Accession No. Assignation menu, insert a check mark for Enable Automatic 
Accession No. Assignation.
When a check mark is inserted, the [Auto Counter Setting...] is enabled, and the automatic 
numbering setting is enabled.
The automatic numbering setting can also be made from the Study menu of the main screen.

3 Open the Automatic Numbering Settings screen.

Click the [Auto Counter Setting...]. 
The Automatic Numbering Settings screen is displayed.

Automatic Numbering Settings screen

4 Set the automatic numbering items.

After the settings are complete, click [OK].

Item Operation

Assign 
Accession No. 
automatically

Insert a check mark to use the automatic numbering setting.

Counter ****

Enter the counter number of the accession number assigned when the Study 
Input screen is opened.
The valid range is from 0 to 999,999,999.
The displayed value **** is the current counter value.

To enable automatic numbering
Check marks must be inserted for the “Enable Automatic Accession No. Assignation” and for 
the “Assign Accession No. automatically” in the Automatic Numbering Settings screen to 
enable the automatic numbering function.

Automatic numbering function and the Study Input screen
When the automatic numbering function is enabled, the Study Input screen can no longer be 
opened, and patient information other than the Accession No. cannot be input.
To input patient information, on the main menu, select Menu > [Study] > [Set Auto 
Numbering] to disable the automatic numbering function.
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7.5.3 Mag Barcode Input tab
Set the input method for the essential items and birth date during input from a magnetic card/barcode.

Mag Barcode Input tab

7.5.4 List Input tab
This sets the study screen using list input.

List Input tab

1 Select the items to be displayed in the List Input tab on the Study Input screen.

To move an item, select the item, and then click  or .

Item Operation

Essential Data
Check the items which are to be set as the essential input data.
The item names of items set as the essential data on the Study Input screen 
turns blue.

Birth Date Input

Click , and select the birth date input method.

Fill in Separate 
Boxes Input the year, month and day into separate boxes.

Fill in a Box with 
Separator

Input the year, month and day using / (slashes) into one 
box.



7. Settings

-87-

2 Set the display order of the Displayed Items.

Items in the Displayed Items are displayed in order from the top of the list starting from the left side.
To change the display order, select the item, and click [Up] or [Down].

3 Set the Model No.

Input a number from 1 to 99 for identifying the camera performing the study.
The input number can be saved to the study file (ccrhis.his) and study history file (ccrhis.hr).

4 Set the storage of the study file.

Click [Browse...] to browse and set the folder where the study file will be saved.

5 Select the Study Status.

6 Select the Study Result.

Item Function

Don’t change The study status in the study file (ccrhis.his) when starting and completing a 
study is not changed.

Change The study status in the study file (ccrhis.his) when starting and completing a 
study is changed according to the conditions.

Item Function

Don’t save The study results are not recorded to the study history file (ccrhis.hr) when 
completing a study.

Add to the file The study results are added to the study history file (ccrhis.hr) when 
completing a study.

Update the study The study results of the study history file (ccrhis.hr) are overwritten when 
completing a study.
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7.5.5 Worklist tab
This screen is displayed when the Worklist tab is clicked.

Worklist tab screen

7.5.5.1 Setting the display items

1 Select the items to be displayed on the Worklist tab (see page 19).

To add or delete a display item, select the item, and then click  or .

2 Set the display sequence of the Displayed Items.

The items on the Displayed Items appear from the left of the list in sequence from the top.
To change the display sequence, select the item, and then click [Up] or [Down].

7.5.5.2 Performing the Worklist Server Settings

1 Set the communication parameters.

2 Check the connections with the server.

Click [Connection Check...].
If the connections have been made properly, the Information screen is displayed.
When [OK] is clicked, the Information screen is closed.

Information screen

Item Operation

Server AE Title
Input the title using not more than 16 single-byte alphanumerics and 
symbols. (Required)
The backslash (\) cannot be input.

Host Name Input no more than 32 characters for the IP address or host name. (Required)

Port No. Input a number from 0 to 65535 as the port number. (Required)
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7.5.5.3 Setting the search conditions

Take the steps below to set the default values of the Worklist Search screen (see page 20).

1 Click [Search Conditions...].

Search Conditions screen is displayed.

2 Set the Search Conditions : Date.

Select the date search condition, and input the condition.
Based on the input condition, studies with the Scheduled Procedure Step Start Date (0040,0002) or 
Scheduled Procedure Step Start Time (0040,0003) are searched.
If no conditions have been input, the search conditions will not be set.

When the Warning screen is displayed
Check out the following when the Warning screen is displayed.
• Is the network operating properly?
• Is the server working properly?

Item Operation

Time
The search is conducted using the range which has been set with the current 
time serving as the reference. 
Input a number from 1 to 24.

Range of Date 
(MM/DD/YYYY)

The search is conducted using a period extending from the start date to the 
end date.
Select the dates in the range extending from 1/1/1870 to 12/31/9999.

Range of Days
The search is conducted using the range which has been set with the current 
date serving as the reference. 
Input a number below 999.
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3 Set the Search Conditions : DICOM Tag Keyword.

Set the search tag in the list box on the left.
Input the value in the text box on the right. An asterisk (*) can be used as a wild card.

4 Save the settings for the search conditions.

Clicking [OK] saves the settings and closes the Search Conditions screen.

5 Set the Worklist Search Interval.

Search Conditions : 
DICOM Tag Keyword

Operation

AE Title (00400001) Input no more than 16 bytes.

Scheduled Station 
Name (00400010) Input no more than 16 characters.

Modality (00080060) Input no more than 16 bytes.

Patient ID (00100020) Input no more than 64 characters.

Scheduled 
Performing 
Physician’s Name 
(00400006)

If the classification of the Component Group is to be used for the input, use 
the equal sign (=) as the delimiter.
First=Second=Third
First: Input no more than 64 characters, Second and Third: No more than 
63 characters

Scheduled Procedure 
Step Location 
(00400011)

Input no more than 16 characters.

Patient Name 
(00100010)

If the classification of the Component Group is to be used for the input, use 
the equal sign (=) as the delimiter.
First=Second=Third
First: Input no more than 64 characters, Second and Third: No more than 
63 characters

Accession No. 
(00080050) Input no more than 16 characters.

Requested Procedure 
ID (00401001) Input no more than 16 characters.

Item Operation

Worklist Search 
Interval

When searching for a worklist while the Study Input screen is displayed, 
input a number from 0 to 60 as the interval after which the worklist is to be 
automatically searched again. (Required)
If 0 has been input, the worklist will not be searched again.

Display Worklist 
Search window

Check this if the Worklist Search screen is to be displayed automatically 
when the Study Input screen is displayed or when the Worklist tab has been 
selected.



7. Settings

-91-

7.5.6 MPPS tab
This screen is displayed when the MPPS tab is clicked.

MPPS tab

1 Set the communication parameters.

2 Check the connections with the server.

Click [Connection Check...].
If the connections have been made properly, the Information screen is displayed.
When [OK] is clicked, the Information screen is closed.

Information screen

Item Operation

Server AE Title Input the title using not more than 16 characters. (Required)
The backslash (\) cannot be input.

Host Name Input no more than 32 characters for the IP address or host name. (Required)

Port No. Input a number from 0 to 65535 as the port number. (Required)

When the Warning screen is displayed
Check out the following when the Warning screen is displayed.
• Is the network operating properly?
• Is the server working properly?
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7.6 Storage
Storage Server, Export (DICOM), and Export (JPEG) can be selected as a storage.
Click the Storage icon to display the Storage screen.
The registered DICOM server storage locations and the export locations for DICOM files and JPEG files 
are displayed in a list, where entries can be added, edited, and deleted.
To exit the screen, click [Close].

Storage screen

7.6.1 Registering the storages
Up to ten storages can be registered, but up to two storages only can be set as the default storages.
Also, up to two storages only can be set as the storages in a single transfer.

1 Display the Create a New Storage screen.

Click [Create...].

Create a New Storage screen
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2 Select the Storage Type.

To output to a DICOM storage server, select Storage Server. To export a DICOM file, select 
Export (DICOM). To export a JPEG file, select Export (JPEG).

3 Select the settings for the storage.

If Storage Server is selected under Storage Type, set the Storage Name, Server AE Title, Host 
Name, Port No., and SOP Class. If Export (DICOM) is selected, set the Storage Name, Storage 
Directory (Folder), and SOP Class. If Export (JPEG) is selected, set the Storage Name and Storage 
Directory (Folder).

4 Set the Image Compression.

Select one of the methods.
When Lossy JPEG has been selected, input a number from 1 to 100 for the JPEG Quality. 
“100” represents the best image quality.

Item Function

Storage Name Input the name using not more than 64 characters.
It is case-sensitive.

Server AE Title Input the title using not more than 16 alphanumerics and symbols.
The backslash (\) cannot be input.

Host Name Input the IP address or host name in 32 or less alphanumerics and 
symbols.

Port No. The field accepts a number from 0 to 65535.

[Connection Check...] Click this to check the connection with the storage server.

Storage Directory 
(Folder)

Click [Browse...] to open the Browse For Folder screen and set the 
folder where the file is stored.

SOP Class Click , and select the class from the list.

Modality The modality which corresponds to the SOP Class is displayed.

Lossless JPEG
The numeral following Lossless JPEG represents the UID of the transfer syntax.
Lossless JPEG (70): 1.2.840.10008.1.2.4.70
Lossless JPEG (57): 1.2.840.10008.1.2.4.57
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5 Check the connection with the server. (When Storage Server has been selected)

When Storage Server has been selected as the Storage Type, click [Connection Check...].
The Information screen is displayed if the connection has been made properly.
When [OK] is clicked, the Information screen is closed.

Information screen

6 Set the storage to the default.

To set as the default storage, check Set as Default Storage.
However, because a maximum of two default storages can be set, it cannot be checked if two storages 
are already set.

7 Register the storages.

Click [OK].

When the Warning screen is displayed
Check the following points if the Warning screen is displayed.
• The network is functioning properly.
• The server is operating properly.
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7.6.2 Advanced export settings (when Export is selected for the storages)
Click [Details...] on the Create a New Storage screen.
The Export Settings screen is displayed.
On this screen, the settings are made for creating directories for storing images, file names, and resizing.
After the settings are complete, click [OK].

Export Settings screen

Item Function

Create Directory 
(Folder)

Check this to set the storage folder name as the Storage Date or Study 
Date.

Filename

When [Saving Datetime] is checked:
“yyyyMMddhhmmssfff.jpg(.dcm)” 
(Year, month, day, hour, minute, second, and millisecond when the file 
was stored.)
When [Study Datetime +  Study ID + ...] is checked: 
“yyyyMMddhhmmssEEEESSIIIttt.jpg(.dcm)”
EEEE: Study ID
SS: Series number
III: Instance number
ttt: Study transfer count

Add Patient Info. to 
the filename

Patient information selected by the radio buttons (Patient ID, Accession 
No., Patient Name) are added to the start of the file name.
The file name is changed to “Patient information” + “_” + “file name.”
Only the file name is used when there is no selected patient information.

Resize (with fixed 
aspect ratio)

This can be set only when Export (JPEG) is selected.
The image size can be modified with a fixed aspect ratio.
[Ratio]:
Click  to specify the percentage that the width and height are reduced 
compared to the original image.
[Size (Width)]:
Click  to select the width of the image after it is reduced in size.
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7.6.3 Setting the storage server
Set the time-out period (second) for transferring to the registered storage server.
Click [Storage Server Settings...] on the Storage screen. The Storage Server Settings screen is 
displayed.
Set the items on the screen, and click [OK].

7.6.4 Changing the registered information
To change the registered information, first click the storage on the list, and then click [Change...].
The Change a Storage screen is displayed so refer to 7.6.1 Registering the storages (see page 92), and 
change the registered information.

7.6.5 Deleting storages
To delete a storage, first click the storage on the list, and then click [Delete].
The warning screen is displayed, and the “Storage will be deleted from the list.” message is displayed.
Click [OK] to delete the storage.

Item Function

Association 
Timeout Input a number from 1 to 600.

Receive Timeout Input a number from 1 to 600.

Send Timeout Input a number from 1 to 600.
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7.7 DICOM Tag
The DICOM Tag screen is displayed when the DICOM Tag icon is clicked.
Click the tabs, and set the parameters.
To save the settings and exit the DICOM Tag screen, click [OK].

DICOM Tag screen

7.7.1 Study tab
On this tab, the DICOM information which is to be saved on the images is set.

Study tab

Item Operation

Create Series for 
Right/Left Eye

If this item is checked, a new series is created when the retinal camera 
mode has been changed or when the right and left eyes have been 
changed.
If it is not checked, a new series will be created only when the retinal 
camera mode has been changed.
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7.7.1.1 Setting image comments

Take the steps below to set the information to be saved in the DICOM information (Image Comment) of 
the images. However, what has been set will not be displayed as the Image Comments (see page 45) of 
the Image Property.

1 Display the Image Comment Settings screen.

Check the Save as “Image comments” item, and then click [Details...].

Image Comment Settings screen

2 Set the characters to be used as the Tag Mark and Separator.

Input one character. For instance, if  “:” is used for the Tag Mark and “/” as the Separator, they will 
be saved as follows.
Example: Brightness:0/Contrast:0/Gamma:1.00

Set “Scheduled 
Performing 
Physician’s Name” to 
“Performing 
Physician’s Name”

This setting takes effect only when the worklist has been acquired.
If it is checked, the scheduled performing physician’s name of the 
acquired worklist is saved as the performing physician’s name of the 
DICOM information on the images. The performing physician’s name 
is not saved when the scheduled performing physician’s name is not 
present in the acquired worklist.
If it is not checked, the User Name (see page 100) is saved as the 
performing physician’s name. If the User Name has not been input, 
performing physician’s name will not be saved.

Window Center/
Window Width

If this is checked, the window center and window width are saved as 
DICOM information on the images.

Save as “Image 
Comments”

Refer to 7.7.1.1 Setting image comments (see page 98).
When the Save as “Image Comments” item is not checked, only 
what has been input for the Image Comments on the Image Property 
screen (see page 45) will be saved.[Details...]

Item Operation
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3 Select the Enabled Items.

To add or delete a display item, select the item, and then click  or .

4 Set the order in which the items are to be saved.

The items displayed as the Enabled Items will be saved in sequence from the top. To change the 
sequence in which the items are saved, select the item, and then click [Up] or [Down].

5 Save the settings and exit the screen.

Click [OK].

7.7.2 Study Logs tab
Select the settings for updating the UIDs if images are to be re-transferred when study logs or past studies 
are displayed.
However, these settings do not apply to studies whose transfer status (see page 31) is “untransferred.”

Study Logs tab

Whichever item is selected, only the transfer time is updated.
Furthermore, it is the information of the images to be re-transferred that is updated and not the information 
of the images saved.

Item Operation

Update “Study Instance 
UID” on re-transfer

If this is checked, the study instance UID is issued as follows.
Model UID. study ID. transfer time (YYYYMMDDHHMMSS)

Update “Series 
Instance UID” on re-
transfer

If this is checked, the series instance UID is issued as follows.
Model UID. study ID. transfer time (YYYYMMDDHHMMSS). 
series number

Update “SOP Instance 
UID” on re-transfer

If this is checked, the SOP instance UID is issued as follows.
Model UID. study ID. transfer time (YYYYMMDDHHMMSS). 
series number. instance number (image number)
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7.8 User Accounts
The User Accounts screen is displayed when the User Accounts icon is clicked.
Manage the information of the login user on this screen.
To save the settings and exit the User Accounts screen, click [Close].

User Accounts screen

7.8.1 Registering users
Up to 20 users can be registered.

1 Display the Create a new account screen.

Click [Create...].

Create a new account screen

Item Operation

User ID
Input no more than 16 characters for the user ID.
No distinction is made between upper case and lower case for the 
letters input for the user ID. Blank spaces cannot be used.

Password Input no more than 16 characters for the password.

Password(confirm) Input no more than 16 characters for the password (confirm).

User Name

Input the name using not more than 63 characters.
The equal sign (=) and backslash (\) cannot be input.
Characters other than the preset specific character set (see page 76) 
cannot be input.

Privilege Select Administrator or General.
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2 Register the users.

Click [OK]. The users are now registered on the user account list.

7.8.2 Changing the user information
The information of registered users can be changed.
Click a user on the user account list, and then click [Change...].
The Change an account screen is displayed. Change User Name and/or Privilege, and click [OK].

Change an account screen

7.8.3 Deleting the user information
The information of registered users can be deleted.
Click a user on the user account list, and then click [Delete].
A Warning screen is displayed, “User will be deleted.” message is displayed. Click [OK] to delete the 
user information.

7.8.4 Resetting the password
The passwords of registered users can be changed.
Click a user on the user account list, and then click [Reset a password...].
The Reset a password screen is displayed. Input the password both into New Password and New 
Password(confirm), and click [OK].

Reset a password screen 

Concerning the user names
The user names are saved as DICOM information (Operator’s Name) on the images. Depending on 
the settings (see page 97), a user name may also be saved as the Performed Physician’s Name.
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7.9 Screen
The Screen screen is displayed when the Screen icon is clicked.
Click the tabs, and set the parameters.
To save the settings and exit the Screen screen, click [OK].

Screen screen
7.9.1 Main Image Info. tab

On this tab, the image information to be displayed on the main image is set when the main & thumbnail 
images are displayed (see page 44) on the screen.
Check the items to be displayed.

Main Image Info. tab

Displayed Items Display Description

Retinal Camera Mode Color is displayed.

Image No. This item is indicated as the No. Image No. The images are displayed 
in the sequence in which they were taken.

X2 If the image is taken at x2, the magnification rate (x2) is displayed.

R/L Either R (right eye) or L (left eye) is displayed.

Content Time The photography time is indicated in hours:minutes:seconds.

Patient ID This item is indicated as the ID: Patient ID.
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7.9.2 Thumbnail Image Info. tab
On this tab, the image information to be displayed on the thumbnail images is set.
Check the items to be displayed.

Thumbnail Image Info. tab

Displayed Items Display Description

Retinal Camera Mode Color is displayed.

Image No. This item is indicated as the No. Image No. The images are 
displayed in the sequence in which they were taken.

X2 If the image is taken at x2, the magnification rate (x2) is displayed.

R/L Either R (right eye) or L (left eye) is displayed.

Content Time The photography time is indicated in hours:minutes:seconds.
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7.9.3 Study Info. tab
On this tab, study information to be displayed at the right of the main screen is set.

Study Info. tab

The items displayed in Displayed Items appear in the study information at the right of  the main 
screen.
To add or delete a display item, select the item, and then click  or .
To change the display sequence, select the item, and then click [Up] or [Down].
For the display items listed below, there are times when no information can be input or when the 
display items themselves are subject to certain conditions.

Displayed Items Display Description

Age

When a worklist is used, the values obtained by calculation from the 
Patient Birth Date (0010,0030) in the acquired worklist are used. If, 
however, there is no value for the Patient Birth Date, the value for 
Patient’s Age (0010,1010) in the worklist is used.
When the study has been input manually, the value obtained by 
calculation from the birth date is used.

Study Status NONE, REGISTER, START, CANCEL or FINISH is displayed.

MPPS Status NONE, IN_PROGRESS, DISCONTINUED or COMPLETED is 
displayed.

Study Input Type UNKNOWN, MANUAL, WORKLIST, SERIAL_READER or 
STUDIX is displayed.

Study Trans Status NONE, START, FINISH, ERROR or FATAL_ERROR is 
displayed.
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7.9.4 Thumbnail Order tab
On this tab, the thumbnail display sequence to be used when the Thumbnails icon was clicked on the main 
screen is set.
When the By Time icon is clicked, the Order by Content Time is applied; when the By Retinal Camera 
Mode icon is clicked, the Order by Retinal Camera Mode is applied.
The Order by Retinal Camera Mode is applied in the order of Retinal Camera Mode, R/L, and Content 
Time.

Thumbnail Order tab

Setting Item Display description

Order by Content Time

Content Time

Sort 
Ascending

The thumbnails are displayed in the sequence of their 
photography times starting with the oldest.

Sort 
Descending

The thumbnails are displayed in the sequence of their 
photography times starting with the most recent.

Order by R/L

R/L
R -  L The thumbnails are displayed for the right eye followed by the 

left eye.

L -  R The thumbnails are displayed for the left eye followed by the 
right eye.

Content Time

Sort 
Ascending

The thumbnails are displayed in the sequence of their 
photography times starting with the oldest.

Sort 
Descending

The thumbnails are displayed in the sequence of their 
photography times starting with the most recent.

>

>
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7.9.5 Loupe tab
On this rtab, the display size and magnification rate for the Loupe function of the main image is set.

Loupe tab

Item Status Function

Displayed Size

L The image is displayed in a square with a side equal to 1/3 the 
vertical length of the main screen.

M The image is displayed in a square with a side equal to 1/4 the 
vertical length of the main screen.

S The image is displayed in a square with a side equal to 1/5 the 
vertical length of the main screen.

Magnification

L The image is displayed at 3.0x size of the main image.

M The image is displayed at 2.0x size of the main image.

S The image is displayed at 1.4x size of the main image.
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7.9.6 C/D Ratio tab
On this tab, the magnification rate in the C/D Ratio screen is set. The rate is used to magnify the image 
when it is clicked.

C/D Ratio tab

Item Status Function

Displayed Size

L Select this option to enlarge the M display size by 1.4x (based on 
the height of the image).

M Normal size

S Select this option to reduce the M display size by 1/2x (based on 
the height of the image).
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7.9.7 Stereo View tab
On this tab, the magnification rate in the Stereo View screen is set. The rate is used to magnify the image 
when it is clicked.

Stereo View tab

Item Status Function

Displayed Size

L Select this option to enlarge the M display size by 1.4x (based on 
the height of the image).

M Normal size

S Select this option to reduce the M display size by 1/2x (based on 
the height of the image).
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7.10 Print
The Print screen is displayed when the Print icon is clicked.
This sets the print operation that is executed when clicking the Print icon in the main screen.
To save the settings and exit the Print screen, click [OK].

1 Set the print operation for the Print icon.

To print using Easy-PhotoPrint EX, add a check mark to the Print with Easy-PhotoPrint EX option.
To print using the simple printing function of the control software, remove the check mark.

2 Save the settings and exit the Print screen.

Click [OK].
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7.11 Study Logs
The Study Logs screen is displayed when the Study Logs List icon is clicked.
Set the number of days being studied for display on the Study Log.
To save the settings and exit the Study Logs screen, click [OK].

Study Logs screen

Click  or  for Study Logs for (1-999), and set the number of days.

7.12 Magnetic Card/Bar Code
Clicking the Magnetic Card/Bar Code icon opens the Magnetic Card/Bar Code Setting screen.
At this screen, the serial/USB communication settings for the magnetic card/barcode reader that is used 
and the settings for the magnetic card/barcode data are made.
For details, please contact a Canon representative or distributor.
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8. Before calling the service technician

8.1 Appearance of the message screen
A message screen appears when trouble has occurred or when there is information for the user.

Message screen (Error)

There are three message screens, each of which is identified by an icon.

Please refer to the message information in the table using the icons, module ids, and message ids.

If any messages not shown in the table are displayed, or if the problem cannot be resolved by the remedies 
listed in the table, please contact your Canon representative or distributor where you purchased this 
product.

Icon Name Reference section

Error 8.2 Error (see page 112)

Warning 8.3 Warning (see page 116)

Information 8.4 Information (see page 125)
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8.2 Error

module id message id Message Detail

00005 5 Specified User ID already exists. The User ID which has been input is already 
registered. Change the User ID.

00008

8 Failed in DICOM communications. - a series of 
operation with SCP

Check the MPPS tab (see page 91), Worklist tab 
(see page 88) or storage settings (see page 92).

10 Failed in DICOM communications. - C-STORE-
RQ

Check the storage settings (see page 92).
11 Failed in DICOM communications. - C-STORE-

RSP

12 Failed in DICOM communications. - C-ECHO-
RQ Check the MPPS tab (see page 91), Worklist tab 

(see page 88) or storage settings (see page 92).
13 Failed in DICOM communications. - C-ECHO-

RSP

14 Failed in DICOM communications. - N-CREATE-
RQ

Check the MPPS tab (see page 91).15 Failed in DICOM communications. - N-CREATE-
RSP

16 Failed in DICOM communications. - N-SET-RQ

17 Failed in DICOM communications. - N-SET-RSP

18 Failed in DICOM communications. - C-FIND-RQ

Check the Worklist tab (see page 88).

19 Failed in DICOM communications. - C-FIND-
RSP

20 Failed in DICOM communications. C-FIND 
returned error status.

21 Failed in DICOM communications. - C-
CANCEL-RQ

00011

1 Fail to open Omron Device. • Check that the OMRON device is connected 
correctly.

• Check that the device number is assigned 
correctly.

• Check that the driver is installed correctly.
2 Fail to close Omron Device.

10002 101 Failed to connect to specified EOS. Check the connection with the EOS digital camera.

10003 2 Incorrect Entry of Date for Search Conditions Open the Search Screen (see page 32) from the 
Study Logs screen, and then input the correct date.

10004

29
Insufficient Free Space in Storage Directory 
No image can be captured.
[** GB]

No images can be taken since the free space on the 
drive containing the storage directory is less than 
1 GB.
Increase the amount of free space on the drive.

3701

Service cannot start.
Service name: MSDTC
Display name: Distributed Transaction 
Coordinator

Set the startup type of the service to a setting other 
than “Disable.”

4100 Error on Saving to External Storage Check that the specfied saving destination can surely 
save the study(ies).

4103 Failed to read the external study.
Try to display the study log file again. If this fails, 
the data may be corrupted. If the data is retained in 
the Temporarily Saved, try saving again.

4106 A folder or file without access rights exists under 
the specified folder. 

Select a folder again in the Browse For Folder 
screen. Select the study logs file folder or a folder at 
the nearest possible level.

4107 The path of the specified folder exceeds the 
maximum length.

Move the folder of the study logs file to a location 
where the folder path is 150 characters or less. Click 
[Folder], and specify the new folder location in the 
Browse For Folder screen.
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10005

1001 Failed to open a port.

• Refer to 7.3.1 Retinal Camera Settings (see 
page 77), and check the port number setting.

• Disconnect the retinal camera communication 
cable, then connect the cable again.

1003 Failed to set a port. Refer to 7.3.1 Retinal Camera Settings (see 
page 77), and check the port number setting.

1007 Power for the retinal camera is turned off or the 
cable is improperly connected.

Check that the computer and retinal camera are 
connected correctly.

1501
Error occurred during communications with the 
retinal camera.
Failed to resend the command frame.

Turn the retinal camera’s power off and back on.

1502
Error occurred during communications with the 
retinal camera.
Failed to resend the reply frame.

1503
Error occurred during communications with the 
retinal camera.
Time-out for No Response

1504
Error occurred during communications with the 
retinal camera.
Time-out for Incomplete Transmission

1603 Cameras are not attached to the main mount and 
sub-mount of the retinal camera. Check that the digital camera is connected correctly.

1701 Connected retinal camera model is different from 
the model setting in this software. Check the model of the retinal camera.

10007 4 JPEG File Saving Error Check how much free memory is left on the drive 
where the data is to be saved.

10010
1 Failed to log in.

Confirm User ID/Password.
Input the User ID and Password registered in the 
user account (see page 100), and log in.

2 It cannot be set without administrator's privileges. Log in using the User ID for which the Privilege has 
been set to the Administrator (see page 100).

10011

2 This application is already running. Use the software application which is running.

101 Set the screen resolution to 1024 × 768 or more. Set the Windows screen resolution to 1024 × 768 or 
more.

102 Set the screen color to 24 bits or more. Set the Windows color quality to 24 bit or more.

110 Operation can be executed by a Windows user 
with Administrator privileges.

Log into Windows using the name of the user 
belonging to the Administrators group.

114 Essential data has not been set up.
Set up essential data. Input the required items.

10012

27

Free space in the drive is not sufficient to capture 
images.
Make up space in the drive by deleting studies in 
Study Logs List.
[Drive:XX freesize: XXGByte(XXbyte)]
[Drive: XX]

Delete studies in the study log screen (see 
page 38) to increase the amount of available space 
in the image storage drive.

29

Image cannot be captured due to insufficient space 
to store captured image.
Make up space in the drive by deleting studies in 
Study Logs List.
[Drive:XX freesize: XXGByte(XXbyte)]

30
Number of captured images exceeds the maximum 
for the study.
No more image can be captured for the study.

End the study, and start a new study.

10019
7 MPPS Communication Error Check that the MPPS server is operating properly.

Check the MPPS tab (see page 91) settings.

11 Study cannot be executed since a study having the 
same Study Instance UID is running.

Check the study information which was transmitted 
from the server.

module id message id Message Detail
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10024
311 No main image is selected. Select an image.

10308 No image is selected. Select the target image.

10031 3 No Manual or Mag/Barcode Input module is set.
At least one is required.

Select the Manual Input Module tab (see page 83) 
or the Mag Barcode Input Module tab (see 
page 86).

10040

104 No Storage Directory Check the name of the storage folder.

105 Failed to create a folder. Check the access permissions for the storage folder.

106 The same file name exists in the storage directory. Either change the name of the storage file, or delete 
the file with the same name.

107 Error occurred when the file was moved to the 
storage directory. Check the access permissions for the storage file.

10045

5
Failed to search worklist.
It may be caused by communication failure with 
the worklist server.

Check that the worklist server is operating properly.

25 Failed to initialize the magnetic card/bar code 
device.

Check the magnetic card/barcode reader connection.
The magnetic card/barcode reader settings need to 
be made.
Please contact a Canon representative or
distoributor.10048 41 Failed to initialize the magnetic card/bar code 

device.

10049

11 Failed to register Patient Info. in the database.
The study progress status could not be saved to the 
study file. Check if the study file (ccrhis.his) is set to 
read-only.

49 Failed to initialize the magnetic card/bar code 
device.

Check the magnetic card/barcode reader connection.
The magnetic card/barcode reader settings need to 
be made.
Please contact a Canon representative or 
distoributor.

50 The studies were not read. Number of studies 
exceeded the maximum to read. 

Please reduce the number of studies in the study file 
(ccrhis.his) to the number of displayable studies.

10052

100 No printer is installed. Install the printer from the Printers and Faxes screen 
in the Control Panel.

200 No main image is selected. Select the printing image.

201
Image Read Error
Only print info. is output since image reading has 
failed.

The printing information and the text “NO IMAGE” 
are printed for images where a reading error has 
occurred.

300 Print Error
Printing is cancelled. Check the printer server and network cable 

connections.
301 Print Error

Printing is cancelled.

10053 8

Failed to communicate with the magnetic card/bar 
code reader.
Check the cable.
Check the settings.

Check the magnetic card/barcode reader connection.
The magnetic card/barcode reader settings need to 
be made.
Please contact a Canon representative or 
distoributor.

10056

204 No Storage Directory
Refer to 7.6 Storage (see page 92), click [Edit] in 
the storage setting screen, and check the storage 
directory.

205 The same file name exists in the storage directory. Either delete the file with the same file name at the 
storage directory, or change the storage.

206 Failed to save JPEG File. Refer to (2) in 2.1 Software (see page 3), and set 
the proper access privileges for the storage folder.

207 Failed to create a folder. Refer to (2) in 2.1 Software (see page 3), and set 
the proper access privileges for the storage folder.

10063 1 JPEG File Saving Error
[Error description]

Refer to the error description, and check the file into 
which the data is to be saved.

module id message id Message Detail
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10067

6 Specified folder does not exist or is not accessible. Specify the folder again.

7 No right to read contents in the folder. Refer to (2) in 2.1 Software (see page 3), and set 
the proper access privileges for the storage folder.

9 Not Recognized as a directory. Specify the folder again.

10 No right to write contents in the folder. Refer to (2) in 2.1 Software (see page 3), and set 
the proper access privileges for the storage folder.

module id message id Message Detail
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8.3 Warning

module id message id Message Detail

10001

1002

Invalid image was captured.
Failed to acquire Retinal Camera Info. within the 
specified time.
No Validity for Current Study

• Do not press the shutter button of the digital 
camera.

• Check that the computer and digital camera are 
connected correctly.

• Turn the equipment’s power off and back on, 
and take a test image.

1009 Photography frequency exceeded the limit.
Please wait.

Images cannot be saved since images were taken 
continuously over a short period of time.
Wait for a few moments, and then take the images.

10002

1000
Failed to connect to EOS.
Check the cable.
Check the power supply.

Check that the computer and digital camera are 
connected correctly.
Check that the digital camera is turned on.

1001

Failed to control EOS digital camera.
Follow the instructions as follows:

1. Turn off LCD monitor on the back if it's on.
2. Close the setting menu if it's displayed.
3. Turn the retinal camera to the eye front image 
mode if it's is in retinal image mode.
4. Release Shutter Release button of the retinal 
camera if it's held down.

When all the items above are cleared, press Retry 
button.

Perform operation based on the message details.

1004 Auto power off option is enabled on EOS.
Select Off for Auto power off.

Refer to the operating instructions of the digital 
camera, and set the digital camera.

1005 Communications with EOS was disconnected.
Check that the computer and digital camera are 
connected correctly. 
Check that the digital camera is turned on.

1006 EOS battery is almost empty.
Supply power with AC adapter.

Supply the power of the digital camera using the AC 
adapter.

1007 EOS setting has been changed.
Reset the setting?

To return to the original setting, click [YES]; 
otherwise, click [NO].

10003

1 Selected study will be deleted. To delete a study, click [OK]; to cancel the deletion, 
click [Cancel].

3 No Storage Selected Select the storage, and then transfer the image.

4 Character '\' cannot be used for Patient ID. Delete the backslash (\).

7 Character '\' or '=' cannot be used for Patient Name. Delete the backslash (\) or equal sign (=).

8 Only alphanumeric characters can be used for 
Patient Name.

Delete the characters which are not single-byte 
alphanumerics or symbols.

203 The study being transferred is selected. Failed to 
transfer. No operations can be performed for studies being 

transferred so wait until the transfer is completed.
204 The study being transferred is selected. Failed to 

delete the study.

11004

Study Logs screen cannot display all logs. Number 
of study logs to be displayed exceeds the 
maximum.
Change the search conditions.

Change the search conditions (see page 32).
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10004

25 Required fields must be entered.
[item]

Input the required items.
The titles of the required items are indicated in blue.

26
The path for storage directory exceeds the 
maximum length.
[Max. *** bytes]

Select a folder where the path for the Image Storage 
Directory (Folder) (see page 80) is fewer than 150 
bytes.

27 Storage directory does not exist. Check that the storage directory (see page 80) 
which has been set actually exists.

28 Drive specified for storage directory (folder) is not 
a fixed disk.

Set the storage directory (see page 80) on the fixed 
disk.

30 Insufficient Free Space in Storage Directory 
[** GB]

Increase the amount of free memory on the fixed 
disk on which the storage directory has been set 
(see page 80).

43 Character ' ' cannot be used. Do not input spaces for the tags and separators of the 
Image Comment Settings screen (see page 98).

4105 Failed to read the external study.
Upgrage the version of the Retinal imaging control 
software NM (CR-1 Mark II) to the same version as 
that you used to save the file, or to a newer version.

10005

103 Over Discharge
Do not operate the retinal camera for a while. Wait for a few moments, and then take the images.

104 EOS Digital camera is not mounted.
Mount the camera or select Sub Camera mode. Mount the digital camera on the retinal camera.

107 Communication Port Error • Turn the retinal camera’s power off and back on.
• Turn the computer’s power off and back on.108 Communication Protocol Error

109 Photography frequency exceeded the limit.
Please wait.

Images cannot be saved since images were taken 
continuously over a short period of time.
Wait for a few moments, and then take the images.

201 Mirror Drive Error in EOS Camera Mode Turn the equipment’s power off and back on, and 
take a test image.202 X-contact Error in EOS Camera Mode

204 Retinal camera was operated in Idle mode.
Do not press the shutter release button of the retinal 
camera while the photography ready lamp is not 
lighted up green.

205 Flash Not Fired Turn the equipment’s power off and back on, and 
take a test image.206 X-contact Error in EOS Camera Mode

10006

1000 Default QA parameters by mode will be changed.
To return the current settings to the default values, 
click [OK] on the QA (Quality Assurance) screen 
(see page 65).

1001 Selected QA parameter set will be deleted.
To delete the current QA parameter set to the default 
value, click [OK] on the QA (Quality Assurance) 
screen (see page 65).

1002 Current QA parameter values will be applied to all 
the selected images.

To apply the current settings to all the selected 
images, click [OK] on the QA (Quality Assurance) 
screen (see page 65).

1003 Selected QA parameter set will be updated.
To overwrite the QA parameter set with the current 
settings, click [OK] on the QA (Quality Assurance) 
screen (see page 65).

10009

1000
Invalid Image Comments
A character/characters for Image Comments is/are 
not supported by Specific Character Set. 

Delete any control characters.

1001
Invalid Image Comments
A character/characters for Image Comments is/are 
not supported by Specific Character Set.

Input using the specific character set.

10010 8
A character/characters for User Name is/are not 
supported by Specific Character Set.
Change the user name.

Input the user name using the specific character set.

module id message id Message Detail
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10011

104 Enter User ID/Password. When logging in, input the user ID and password.

105 Enter in alphanumeric. Input the user ID/password in single-byte 
alphanumeric characters.

109
Application will be closed.
Press Cancel button and log in to the application to 
view the details of the transfer error.

To check the details of the transfer error, click 
[Cancel], and then log in.

10012 28

Image can be captured but the storage space for 
captured images runs short.
Make up space in the drive by deleting studies in 
Study Logs List.

Delete studies in the study log screen to increase the 
amount of available space in the drive.

10013

50 Images stored for more than the specified periods 
will be deleted.

To delete the image, click [OK].

66 All the studies will be closed and the current user 
will be logged off.

To log off, click [OK].

85 Application cannot be terminated during transfer. Close all studies after transfer, then exit the 
software.

86 All the studies will be closed and then the 
application will be.

To end the study and exit the software, click [OK].

10019

10
A study with same Accession No. or Patient ID is 
now in progress.
Do you want to create a new study ?

To start as a new study, click [YES].

12
A study with same Accession No. or Patient ID is 
now in progress.
Do you want to update ?

To update the study information, click [YES].

10020

1000 No Storage Selected
Image(s) will not be transferred. Select the storage, and then transfer the image.

1001
Transfer for this study is in progress.
You can't transfer it before the transfer is 
completed.

Wait until the transfer is completed before 
performing the transfer.

10023

1 Invalid Values for Birth Date Input the correct birth date.

5 Patient Info. set as any of essential data items are 
not entered. Input the required item that is displayed.

6
The length of either of 5 Patient Name fields is too 
long.
Shorten the length to 60 characters or less.

Shorten the length to 60 characters or less.

12 Invalid character was entered to the field. Re-input the data based on the information displayed 
in [Details].

14 Line feed code cannot be entered to Study 
Description field. Delete the line feed code.

15
Too Long Patient Name. 
Shorten the total length of the 5 items to 60 
characters or less.

Input the Patient name in 60 characters or less for all 
five items total.

16 Length of Accession No. exceeds the limit. Input within the limited length.

17
A character/characters for Accession No. is/are not 
supported by Acceptable Character Set or Specific 
Character Set.

Input using the designated input character type or 
specific character set.

18 Length of Patient ID exceeds the limit. Input within the limited length.

19
A character/characters for Patient ID is/are not 
supported by Acceptable Character Set or Specific 
Character Set. Input using the designated input character type or 

specific character set.
21

A character/characters for Study Description is/are 
not supported by Acceptable Character Set or 
Specific Character Set. 

22 Character '\' or control character cannot be used for 
Accession No.

Delete the backslash (\) and any control characters.
23 Character '\' or control character cannot be used for 

Patient ID.

module id message id Message Detail



8. Before calling the service technician   (Warning)

-119-

Continued on the following page >> 

10023

24 Character '\,' line feed, or control character cannot 
be used for Study Description. Delete the backslash (\), line feed code, and any

control characters.
29 Character '\', '=', '^' or control code cannot be used 

for Last Name.

30 Multi-byte character cannot be used for Last 
Name. Delete the multi byte characters.

31 Character '\', '=', '^' or control code cannot be used 
for First Name.

Delete the backslash (\), line feed code, and any 
control characters.

32 Multi-byte character cannot be used for First 
Name. Delete the multi byte characters.

33 Character '\', '=', '^' or control code cannot be used 
for Middle Name.

Delete the backslash (\), line feed code, and any 
control characters.

34 Multi-byte character cannot be used for Middle 
Name. Delete the multi byte characters.

35 Character '\', '=', '^' or control code cannot be used 
for Prefix.

Delete the backslash (\), line feed code, and any 
control characters.

36 Multi-byte character cannot be used for Prefix. Delete the multi byte characters.

37 Character '\', '=', '^' or control code cannot be used 
for Suffix.

Delete the backslash (\), line feed code, and any 
control characters.

38 Multi-byte character cannot be used for Suffix. Delete the multi byte characters.

39 Out-of-Range Birth Date (A date earlier than 1869 
or later than tomorrow is entered.) Input the correct birth date.

40 Entered date is invalid for Birth Date.

41 A character/characters for Patient ID is/are not 
supported by Specific Character Set. 

Input using the specific character set.

42 A character/characters for Accession No. is/are not 
supported by Specific Character Set. 

43 A character/characters for Last Name is/are not 
supported by Specific Character Set. 

44 A character/characters for First Name is/are not 
supported by Specific Character Set. 

45 A character/characters for Middle Name is/are not 
supported by Specific Character Set. 

46 A character/characters for Prefix is/are not 
supported by Specific Character Set. 

47 A character/characters for Suffix is/are not 
supported by Specific Character Set. 

48 A character/characters for Study Description is/are 
not supported by Specific Character Set. 

55 A character/characters for Last Name is/are not 
supported by Acceptable Character Set.

56 A character/characters for First Name is/are not 
supported by Acceptable Character Set.

57 A character/characters for Middle Name is/are not 
supported by Acceptable Character Set.

58 A character/characters for Prefix is/are not 
supported by Acceptable Character Set.

59 A character/characters for Suffix is/are not 
supported by Acceptable Character Set.

60 All the items are disabled to input. Check the input-prohibited items.

61 There is no header string set up in Input Format.
Do you want to start study?

Check the header character string that was set in 
Input Format (see page 84).
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10024

4 Character '\' or line feed code cannot be used for 
Study Description. Delete the backslash (\) or line feed code.

11004 A character/characters for Study Description is/are 
not supported by Specific Character Set. Input using the specific character set.

11005 One or more studies are in progress. End the study.

12001 Number of selected images is not two. Select two images.

10026

102 Enter essential data.
[item] Input the required items.

103 Enter in alphanumeric except '\'.
[item]

Delete the backslash (\).
104 Character '\' cannot be used.

[item]

105 A character/characters is/are not supported by the 
specified character set. Input using the specific character set.

10027

1001 No default is registered. When a storage has been registered, check “Set as 
Default Storage” for one of the storages.

1101 Length for a storage path exceeds the maximum.
[Max. ***]

Select a folder where the number of characters for 
the Image Storage Directory (Folder) (see 
page 80) is fewer than 150 characters.

1102 Enter essential data.
[item] Input the required items.

1103 Enter in alphanumeric.
[item] Use alphanumerics for the input.

1104 Enter in numeric.
[item] Use numerics for the input.

1105 Duplicated Storage Name Change the Storage Name.

1106 Entered value exceeds the limit.
[item (*** - ***)] Set to a value which does not exceed the input limit.

1107 Entered value could not be checked. Use alphanumerics for the input.

1110 Association with Storage Server was rejected.
Check the settings and status of Storage Server.

• Check that the storage server is operating 
properly.

• Check the settings on the Create a New Storage 
screen (see page 92).

1111 Enter in alphanumeric except '\'. Delete the backslash (\).

1401 Storage will be deleted from the list. To delete the storage, click [OK].

2001 Number of selected storages exceeds the 
maximum.

Up to two storages can be checked for “Set as 
Default Storage.”

10028

104 User will be deleted. To delete the user, click [OK].

202 No Essential Data Input the required items.

203 Enter in alphanumeric. Use single-byte alphanumerics for the input.

204 Character '\', '=' or control code cannot be used.
[item]

Delete the backslash (\), equal sign (=) or control 
code.

205 Wrong Confirmation Password. 
Enter the password again.

Input the same characters as for Password into 
Password(confirm).

207 A character/characters is/are not supported by the 
specified character set. Input using the specific character set.

302 Character '\', '=' or control code cannot be used.
[item]

Delete the backslash (\), equal sign (=) or control 
code.

305 A character/characters is/are not supported by the 
specified character set. Input using the specific character set.

402 No Essential Data
[item] Input the required items.

403 Enter in alphanumeric.
[item] Use alphanumerics for the input.
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10028

404 Wrong Confirmation Password.
Enter again.

Input the same characters as for Password into 
Password(confirm).

502 No Essential Data
[item] Input the required items.

503 Enter in alphanumeric.
[item] Use alphanumerics for the input.

504 Wrong Old Password. 
Enter the password again. Input the registered password.

505 Wrong Confirmation Password. 
Enter the password again.

Input the same characters for New Password and 
New Password(confirm).

508 New password is the same as the old password.
Enter again.

Do not input the Current Password as the New 
Password.

10031 11
Invalid Module File Combination.
To use the MPPS module, enable the worklist 
module.

When the MPPS tab (see page 91) has been set, set 
the Worklist tab (see page 88) as well.

10033 201 Print Adjustment parameters will be updated. To update the parameters, click [OK].

10044

9 Association with MPPS Server was rejected.
Check the settings and status of MPPS Server.

• Check that the MPPS server is operating 
properly.

• Check the MPPS tab (see page 91) settings.

10
Invalid Server AE Title
Check that valid characters are entered for AE 
Title.

Check the MPPS tab (see page 91) settings.11
Invalid Server Host Name
Check that valid characters are entered for Host 
Name.

12
Invalid Port Number
Check that a numeric within the range between 0 
and 65535 is entered.

10045

7 Association with Worklist Server was rejected.
Check the settings and status of Worklist Server.

• Check that the worklist server is operating 
properly.

• Check the Worklist tab (see page 88) settings.

8 Specified value for Time is out of range. 
Enter a value between 1 and 24.

Refer to 7.5.5.3 Setting the search conditions 
(see page 89).

9 Specified Range of Date are out of range. 
XXXXX - XXXXX

10 Specified Range of Days are out of range. 
Enter values between 0 and 999.

11
Invalid Worklist Search Interval.
Check that a numeric within the range between 0 
and 60 is entered.

12
Invalid Server AE Title
Check that valid characters are entered for AE 
Title.

Refer to 7.5.5.2 Performing the Worklist Server 
Settings (see page 88).13

Invalid Server Host Name
Check that valid characters are entered for Host 
Name.

14
Invalid Port Number
Check that a numeric within the range between 0 
and 65535 is entered.

16

Invalid Search Condition Value(s)
Selected item has an invalid character or the length 
is too long.
[XXXX] (DICOM TAG Name+DICOM TAG 
Number)

Refer to 7.5.5.3 Setting the search conditions 
(see page 89).

18

The same DICOM tag is already set up for Search 
Conditions.
[XXXX] (DICOM TAG Number+DICOM TAG 
Name)

It is not possible to register a multiple number of the 
same DICOM tag.
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10045

19 Specified End Date is earlier than Start Date. Input a date later than the Start Date as the End Date.

20

Length of acquired worklist item is too long.
The following tag number item(s) are cut off.
[XXXX] (DICOM TAG Number+DICOM TAG 
Name) The transfer data of the worklist server does not 

meet the DICOM standards. Check the worklist 
server settings.

21

Acquired worklist item format is invalid.
The following tag number item(s) are not acquired.
[XXXX] (DICOM TAG Number+DICOM TAG 
Name)

10048

1 Invalid Values for Birth Date Input the correct birth date.

5 Patient Info. set as any of essential data items are 
not entered.

Input the patient information that was set in the 
essential data (see page 83).

6
The length of either of 5 Patient Name fields is too 
long.
Shorten the length to 60 characters or less.

Shorten the length to 60 characters or less.

12 Invalid character was entered to the field. Check the details of the displayed item, and enter it 
again.

14 Line feed code cannot be entered to Study 
Description field. Delete the line feed code.

22 Character '\' or control character cannot be used for 
Accession No.

Delete the backslash (\) and any control characters.
23 Character '\' or control character cannot be used for 

Patient ID.

24 Character '\,' line feed code, or control character 
cannot be used for Study Description.

Delete the backslash (\), line feed code and any 
control characters.

29 Character '\', '=' or control code cannot be used for 
Patient Name. Delete the backslash (\) and any control characters.

30 Multi-byte character cannot be used for Patient 
Name. Delete the multi byte characters.

39 Out-of-Range Birth Date (A date earlier than 1869 
or later than tomorrow is entered.) Input the correct birth date.

40 Entered date is invalid for Birth Date.

42 A character/characters for Patient ID is/are not 
supported by Specific Character Set. 

Input using the specific character set.

43 A character/characters for Accession No. is/are not 
supported by Specific Character Set. 

44 A character/characters for Patient Name is/are not 
supported by Specific Character Set. 

45 A character/characters for Study Description is/are 
not supported by Specific Character Set. 

46 A character/characters for the field is/are not 
supported by Specific Character Set. 

47 A character/characters for the field is/are not 
supported by Specific Character Set. 

48 A character/characters for the field is/are not 
supported by Specific Character Set. 

49 Entered characters are not acceptable because they 
do not match Specific Character Set. Delete the single-byte Japanese kana characters.

50 Length of the acquired item is too long.
The following item(s) is/are cut off.

Check the information input in the magnetic card or 
barcode.
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Continued on the following page >> 

10049

7 Entered Model No. is not numeric or the value is 
out of the range between 1 and 99. Set the model number to a number from 1 to 99.

8 Length for storage path for the study file is too 
long. Shorten to less than 80 bytes.

Set the length of the storage path to less than 80 
bytes.

22 Character '\' or control character cannot be used for 
Accession No. The study information in the study file (ccrhis.his) is 

invalid. Delete the backslash (\) and any control 
characters.23 Character '\' or control character cannot be used for 

Patient ID.

24 Character '\,' line feed code, or control character 
cannot be used for Study Description.

The study information in the study file (ccrhis.his) is 
invalid. Delete the backslash (\), line feed code, and 
any control characters.

25 Character '\', '^' or control code cannot be used for 
Patient Name.

The study information in the study file (ccrhis.his) is 
invalid. Delete the backslash (\) and any control 
characters.

26 Multi-byte character cannot be used for Patient 
Name.

The study information in the study file (ccrhis.his) is 
invalid. Delete the multi byte characters.

29 Character '\', '^' or control code cannot be used for 
Referring Physician.

The study information in the study file (ccrhis.his) is 
invalid. Delete the backslash (\) and any control 
characters.

39 Out-of-Range Birth Date (A date earlier than 1869 
or later than tomorrow is entered.) The study information in the study file (ccrhis.his) is 

invalid. Input the correct birth date.
40 Entered date is invalid for Birth Date.

41 A character/characters for Patient ID is/are not 
supported by Specific Character Set. 

The study information in the study file (ccrhis.his) is 
invalid. Input using the specific character set.42 A character/characters for Accession No. is/are not 

supported by Specific Character Set. 

43 A character/characters for Patient Name is/are not 
supported by Specific Character Set. 

44 Entered characters are not acceptable because they 
do not match Specific Character Set.

The study information in the study file (ccrhis.his) is 
invalid. Delete the single-byte Japanese kana 
characters.

45 A character/characters for Referring Physician is/
are not supported by Specific Character Set. The study information in the study file (ccrhis.his) is 

invalid. Input using the specific character set.
46 A character/characters for Study Description is/are 

not supported by Specific Character Set. 

52 Folder for study file is not set. Specify the folder to save the study file (ccrhis.his).

10050

2
Length value for Accession No. of Input 
Restrictions is not numeric or is not in the range of 
1 to 16.

Set the length limitation of the Accession No. to 16 
digits or less.

3 Character set for Accession No. is not specified. Specify the input character type.

6 Length value for Patient ID of Input Restriction is 
not numeric or is not in the range of 1 to 64.

Set the length limitation of the Patient ID to 64 
characters or less.

7 Character set for Patient ID is not specified.

Specify the input character type.10 Character set for Patient Name is not specified.

11 Character set for Study Description is not 
specified.

13 Starting Value is not numeric or out of range. Set the Starting Value using a number in the correct 
range.

15 Total length of Starting Value and Accession No. 
Header String exceeds the limit.

Adjust the length of the header string to set the total 
length of the starting value and header string within 
the length limitation.

16 Counter value is set to 1. Check the value of the counter.

17 Header String for Patient ID exceeds the 
maximum length.

Set the length of the Header string within the length 
limitation.
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10050

18 Character '\' or control character cannot be used for 
Patient ID. Delete the backslash (\) and any control characters.

19
A character/characters for Patient ID is/are not 
supported by Acceptable Character Set or Specific 
Character Set. 

Input using the designated input character type or 
specific character set.

20 Header String for Accession No. exceeds the 
maximum length.

Set the length of the Header string within the length 
limitation.

21 Character '\' or control character cannot be used for 
Accession No.. Delete the backslash (\) and any control characters.

22
A character/characters for Accession No. is/are not 
supported by Acceptable Character Set or Specific 
Character Set.

Enter using the designated input character type or 
specific character set.

23 Header String for Study Description exceeds the 
maximum length.

Set the length of the Header string within the length 
limitation.

24 Character '\' or control character cannot be used for 
Study Description. Delete the backslash (\) and any control characters.

25
A character/characters for Study Description is/are 
not supported by Acceptable Character Set or 
Specific Character Set. 

Enter using the designated input character type or 
specific character set.

26 Patient/Study Info. Setting Error Set again the Patient/Study Info. based on the 
information displayed in [Details].

29
Reset the maximum Length and Header string for 
Accession No. so that Counter value will be two 
digits or more.

Refer to the message details, and set the Accession 
No.

10053 1000 This type of a magnetic card/bar code reader 
cannot use Connection Check function. Check the magnetic card/barcode reader settings.

10063

1001 Enter essential data.
[item] Input the required item that is displayed.

1002 Enter in numeric.
[item]

Input the displayed item in single-byte alphanumeric 
characters.

1003 Entered value exceeds the limit.
[item (*** - ***)] Input the displayed item within the limitation.

1004 Entered value could not be checked. Check the input value in the JPEG Settings 
screen (see page 70), and set it again if necessary.

1005 Entered value is not numeric or out of range.
[item]

Enter a value within the correct range for the 
displayed item.

10065 4097 C/D Ratio data will be updated. Click [OK] to overwrite the C/D ratio data. 
To cancel overwriting, click [Cancel].
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8.4 Information
module id message id Message Detail

10002 10100 Connection to the specified EOS is successfully 
established.

Click [OK].

10003 105 No Untransferred Study

10004 31 Free Space in Storage Directory 
[** GB]

10027 1109 Association with Storage Server succeeded.

10044 8 Association with MPPS Server succeeded.

10045 6 Association with Worklist Server succeeded.

10051 1 No item can be set.

10053 10000 Connection to the magnetic card/bar code reader is 
successfully established.
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<- -> 58

A
Acceptable Character Set 84
Accession No. 10, 11, 14, 17
AE Title 74
Area 55
Area C/D ratio 56
Area Ratio 55
Automatic Accession No. Assignation 85

B
Birth Date 11, 14
Birth Date Input 83, 86
Brightness 60, 65
By Time 45

C
C/D ratio 54
COM Port 77
Compare Studies 52
Contrast 60, 65
Contrast/Brightness 50
Coordinate Hues 65
Counter 85
Cup 56

D
Delete the Dot 56
DICOM Tag Keyword 90
Disc 55
Display Magnification 59
Display size 106, 107, 108
Display warning when available drive size is less than 80
Display Worklist Search window 90
Draw cursor 55

E
Easy-PhotoPrint EX screen 64
Essential Data 83, 86
Ethnic Group 11
Export 92

F
Filler Character 84
First Name 11
Form a Shape 56

G
Gamma 60, 65
Grayscale Conversion 79

H
Hand 54
Horizontal 55
Horizontal C/D ratio 56
Host Name 88, 91, 93
Hue 60, 65

I
Image comments 46, 98
Image Compression 93
Image Format 79
Image Property 46
Image Quality 79
Image Size 79
Image Storage Directory (Folder) 80
Initial enlargement cursor 55
Input Format 84
Input-Disabled Data 83
Insert the Dot 56
Institution Name 75
Institutional Department Name 75
ISO Speed 79

L
Last Name 11
Line 55
Line ratio 57
List Input tab 86
Location 75
Logging off 29
Loupe 106

M
Magnification rate 106
Main and Thumbnails display 44
Main, Thumbnails, and Study Information 53
Manual Input tab 11
Middle Name 11
Modality 74, 93
Move/Apply Effects to Both Images 58

N
Normal View 42

O
Order by Content Time 105
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Password 7, 100
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Patient Info Edit screen 68
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Photography ready lamp 23
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Print 109
Print information 62
Printing parameters 60
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Rejected image 26, 67
RGB Channel 49

S
Save period 81
Search screen 32
Series Instance UID 99
Server AE Title 88, 91, 93
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Skip Study Input 22
SOP Class 74, 93
SOP Instance UID 99
Specific Character Set 76
Station Name 75
Stereo View 58
Storage Directory (Folder) 93
Storage Name 93
Storage Server 92
Storage Type 93
Straight line 57
Study 11
Study Description 12, 14, 23
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Study log files 31
Study logs 31
Study tab 10
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T
Temporarily Saved 31
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Thumbnails Only 41, 53
Transfer 33
Transfer All 34
Transfer Error 28
Transfer Error icon 8
Transfer icon 8, 31
Transfer status icon 27, 31
Turning display of rejected images on and off 45
Turning display of the study information screen on and off
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Two-Row Thumbnails display 44
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User Name 100

V
Version information 72
Vertical 55
Vertical C/D ratio 56
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W
Worklist 19
Worklist Search Interval 90
Worklist tab 19
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